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1 Oxygraph +

1.1 Introduction to the Oxygraph +

The Oxygraph+ oxygen electrode control unit is designed to provide PC control of oxygen uptake or
evolution measurements across a broad range of applications from studies of mitochondrial and
cellular respiration to studies of isolated chloroplast suspensions or leaf-discs in photosynthesis
research applications. In conjunction with user-friendly OxyTrace+  data acquisition and system
configuration software, the Oxygraph+ oxygen electrode control unit provides an effective tool for
the measurement of oxygen signals from the S1 Clark type electrode disc mounted in one of a
range of liquid and gas-phase oxygen electrode chambers with quick and easy system calibration
and configuration.

An Oxygraph+ system may be configured as a single or multi-channel setup in order to make
comparative measurements of oxygen in either liquid or gas-phase from multiple samples.
Simultaneous recording of an optional auxiliary input signal (e.g. temperature, pH, fluorescence,
TPP+ or other specific ion electrodes etc) is also possible using the appropriate accessory
apparatus.

A system comprises a minimum of one (maximum of eight) Oxygraph+ control units connected via
USB port to a Windows® PC. Each control unit features a built-in magnetic stirrer and all the
electronics required to control and measure the signal from the oxygen electrode. Oxygraph+ is
compatible with all existing liquid and gas-phase Hansatech oxygen electrode chambers and
accessories. Oxygraph+ control units may be freely interspersed with Oxytherm+ electrode control
units within a multi-channel system. The control unit connects to a PC via the USB port: There is
no requirement for separate loggers, internal PC interfaces or A/D cards. Laptop or notebook
computers are therefore just as suitable as a desktop PC and provide a highly portable, compact
system whenever bench space is limited.
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1.2 Oxygraph + Inventory

What you have received and what additional items you will
require.

Upon delivery, please check the items you have received against the checklist below. If you find
that an item is missing, please contact Hansatech Instruments as soon as possible.

· OXYG1+ - Oxygraph+ electrode control unit 
· DW1 - Oxygen electrode chamber 
· S1 - Oxygen electrode disc 
· S1/SMB - SMB-SMB Electrode cable 
· A2 - Electrode disc membrane applicator tool 
· A3 - Top plate key & alignment jig 
· S2/P - Pack of 5 magnetic followers 
· S3 - Spare reaction vessels 
· S4 - 30m reel of PTFE membrane 
· S7A - Spare O-rings set for DW1/AD 
· S16 - Electrode cleaning kit 
· USB2.0 A to B - 2m USB cable with A-plug to B-plug 
· DW1MAN - User Manual
· 980266T - 12V Power Supply
· 980257 - DW Accessory Kit

1.3 S1 Electrode Disc

1.3.1 Introduction

1.3.1.1 Introduction

The S1 electrode was designed in the early 1970's during a collaborative project between Prof.
David Walker, Prof. Tom Delieu and Hansatech Instruments. The first S1 went on sale in 1974 and
has remained largely unchanged in over 30 years. A range of complementary instruments have
been developed over the years in order to meet the needs of emerging trends in the scientific
world. Modern oxygen measurement systems incorporate the S1 electrode providing sensitive and
reliable tools for a vast range of applications ranging from the demonstration of oxygen evolution
from photosynthetic organisms to the analysis of mitochondrial respiration rates. 

mailto:info@hansatech-instruments.com
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The Hansatech Instruments oxygen electrode disc is a specialised form of electrochemical cell
known as a Clark type polarographic sensor which comprises a resin bonded central platinum
cathode and a concentric silver anode. During measurements a 50% saturated potassium chloride
(KCl) electrolyte solution forms a bridge between the 2 electrode elements via the aid of a fine
paper wick and a fine layer of PTFE membrane which is selectively permeable to oxygen
molecules. These are applied to the electrode disc during the preparation process and are held in
place with an O-ring. Once preparation of the electrode is complete, the disc assembly is mounted
into the base of an electrode chamber with the membrane covered dome section of the disc
forming the floor of the reaction vessel. The electrode disc is connected to a control unit which
supplies a polarising voltage of 700mV. In the presence of oxygen, a polarised disc generates a
small current which is directly proportional to the concentration of oxygen in the reaction vessel
above the cathode. This current is converted to a voltage, conditioned and digitised with high
resolution before display by the electrode control unit.

1.3.1.2 Electrode Disc Theory

The oxygen electrode is a specialised form of electrochemical cell which consists of two
electrodes immersed in an electrolyte solution. Typically, a 50% saturated solution of KCl
is used in oxygen electrode systems. This is prepared by dissolving 17.5g of anhydrous
salt in 100ml of de-ionised water at 25°C. Application of a polarising voltage of 700 mV
ionises the electrolyte and initiates current flow via a series of electrochemical reactions. In
the case of KCl electrolyte the following reactions occur:

Oxygen is consumed during the electrochemistry, thus the magnitude of the current flow is
related to the oxygen concentration of the surrounding media. This type of electrode
sensor was first developed by Clark (1956) to measure oxygen in blood samples. As a
result it is often referred to as The Clark Electrode.

1.3.1.3 Operational Principles

The following text and image are based on the chapter "The Principle of Oxygen Measurement"
from the book "The Use of the Oxygen Electrode & Fluorescence Probes in Simple Measurements
of Photosynthesis" by Prof. David A. Walker (Oxygraphics Ltd. 1987). Hansatech Instruments
oxygen electrode systems for photosynthesis and respiration measurements take one of 2 forms,
liquid or gas-phase. The measurement techniques for each form are quite different, however, the
underlying principles of the measurement of oxygen remain the same. Oxygen dissolved in the
reaction vessel of liquid-phase systems or that which accumulates in the sample chamber of gas-
phase systems is detected polarographically by either the S1 or S1/MINI (in Oxytherm oxygen
measurement systems) Clark type electrodes (Clark, 1956). Both oxygen electrode discs comprise
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a relatively large (2mm diameter) platinum cathode and a concentric silver anode immersed in,
and linked by, an electrolyte solution. Both electrodes are set in an epoxy resin disc; the cathode
at the centre of a dome and the silver anode in a circular groove named the well or electrolyte
reservoir, surrounding the dome. The electrodes are protected by a thin PTFE (Teflon) membrane
which is permeable to oxygen. The purpose of the dome is to stretch the membrane smoothly over
the surface of the platinum cathode and to allow it to be secured in position by an O-ring. The
membrane also traps a thin layer of electrolyte (a solution, which usually contains potassium
chloride) over the surface of the electrodes. A paper spacer is placed beneath the membrane as a
wick in order to provide a uniform layer of electrolyte between anode and cathode.

When a small voltage is applied across these electrodes, so that the platinum is made negative
with respect to the silver, the current which flows is at first negligible and the platinum becomes
polarised (i.e. it adopts the externally applied potential). As this potential is increased to 700 mV,
oxygen is reduced at the platinum surface, initially to hydrogen peroxide H2O2 so that the polarity
tends to discharge as electrons are donated to oxygen (which acts as an electron acceptor). The
current which then flows is stoichiometrically related to the oxygen consumed at the cathode. The
diagram above represents the oxygen electrode reactions. When a potentiating voltage is applied
across the two electrodes, the platinum (Pt) becomes negative (i.e. becomes the cathode), and the
silver (Ag) becomes positive (the anode). Oxygen diffuses through the membrane and is reduced
at the cathode surface so that a current flows through the circuit (which is completed by a thin
layer of KCl solution or other electrolyte). The silver is oxidised and silver chloride deposited on
the anode. The current which is generated bears a direct, stoichiometric, relationship to the
oxygen reduced and is converted to a digital signal and recorded by an electrode control unit.
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1.3.2 Electrode Preparation

1.3.2.1 Electrode Disc Preparation

Before use, the electrode disc needs to be prepared in such away that an electrolyte bridge is
formed between the anode and cathode in order for current to flow in the presence of oxygen.
Various different compositions of electrolyte have been used however, Hansatech Instruments
recommend a 50% saturated solution of potassium chloride which is proven to work well in many
different applications.

Stage 1
Ensure the electrode disc is clean paying particular attention that the silver anode is free from any
deposits of silver chloride (brown deposit) or silver oxide (black deposit). If traces of these
substances are present, clean the electrode thoroughly according to our recommended cleaning
procedure.

Stage 2
Stage 2 Using a Pasteur pipette, place a small drop of electrolyte on top of the dome of the
electrode disc. Place a further 3 - 4 drops of electrolyte in the well of the electrode disc ensuring
that the silver anode is completely covered
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Stage 3
Place a 1.5 - 2cm2 paper spacer over the drop of electrolyte on the electrode dome. When
complete, this paper spacer will act as a wick to form an electrolyte bridge between the anode
and cathode. It is therefore critical that the spacer paper is of the correct size. From over 35 years
of experience, Hansatech Instruments recommend using ultra-fine cigarette paper such as Rizla
Blue. This product works particularly well as it is manufactured to a very tight thickness tolerance
ensuring a good, even layer of electrolyte. When cutting spacer paper from Rizla Blue cigarette
papers, take care not to use the gummed or folded section of the paper. If the folded section is
used, ensure that this is at the very edge of the square spacer. Holding the PTFE membrane with a
pair of forceps, use a sharp knife (or scissors) to cut a slightly larger section of membrane from
the reel. Take care not to touch the membrane excessively as grease from finger prints can restrict
the performance of the electrode. Carefully lay the section of membrane across the spacer paper
on the dome of the electrode.

Stage 4
Stage 4 Place the small electrode disc O-ring over the end of the membrane applicator tool. Hold
the applicator vertically so that the O-ring end of the applicator locates very gently over the dome
so as not to damage the PTFE membrane. In one smooth motion, push the applicator downwards
so that the O-ring slides over the electrode dome and holds the spacer and membrane securely in
place. Check that the membrane and spacer are smooth and free from trapped air bubbles,
particularly over the platinum cathode itself. If the preparation is uneven, it will have an overall
effect on the response time and sensitivity of the electrode. Also ensure that the spacer paper is
in contact with the electrolyte in the well. If necessary, top the well up with a few drops of
electrolyte ensuring that the silver anode is completely covered by the KCl.



13Oxygraph +

© 2019 Hansatech Instruments Ltd

Stage 5
Place the larger O-ring on the recess around the electrolyte well. If this second O-ring is not in
place when the disc is installed into the electrode chamber, the silver anode will not be sealed
from ambient air and measurements may be affected. Take care to ensure that the edges of the
membrane and/or spacer paper do not contact the larger O-ring as this could affect the seal when
the disc is installed into the electrode chamber. If the corners of the membrane and/or spacer
paper protrude too much from the preparation, these may be trimmed carefully with a pair of
sharp scissors or tucked carefully into the electrode well.
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In Summary...

The finished, prepared oxygen electrode disc should have a smooth covering of spacer paper and
PTFE membrane across the electrode dome. The electrolyte well should be topped up with KCl
ensuring that some of the spacer paper is in contact with the electrolyte itself. Ensure everything
is done correctly by cross referencing against the checklist below:

· The electrode disc is clean,
· The electrolyte is a 50% saturated potassium chloride
· 1 drop of electrolyte on the platinum cathode
· 3 - 4 drops of electrolyte in the well
· Spacer paper is 1.5 - 2cm2
· Spacer is not cut from the creased or gummed section
· Spacer paper placed centrally on the dome
· PTFE membrane cut slightly larger than spacer paper
· PTFE handled with forceps
· PTFE place centrally over spacer paper on the dome
· Smaller O-ring applied using membrane applicator tool
· Secured membrane is smooth and free from creases and bubbles across the platinum cathode
· There is sufficient electrolyte in the well to allow contact with the spacer paper
· Excess PTFE membrane is trimmed
· Larger O-ring placed in recess around the well
· Larger O-ring is not in contact with excess PTFE membrane

1.3.2.2 Testing the Response of the Electrode Disc

Once the electrode disc has been correctly prepared, it is advisable to check the response of the
disc prior to mounting the disc within the electrode chamber.

Before proceeding, you will need to ensure that the electrode control unit you are using is
correctly connected to the PC and that it is communicating with the OxyTrace+  software. If you
are experiencing problems with communications between the control unit and software, please
refer to the Software Initialisation section of this document.

To check the response, connect the electrode disc to the rear of the control unit at the electrode
input using the S1/ADL electrode connection cable. Start a recording. The signal will initially be
extremely high and displayed as nanoamps (nA) and will take a few minutes to stabilise at an air
line level. A new or well maintained disc should read approx. 1600 nA in air but this may vary
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between ±240nA. Once the electrode signal is stable, breathe exhaled air across the disc and
observe the reaction on the graph screen. The signal should be plotted as in the diagram below.

The first deviation in signal after breathing across the disc is induced due to a large increase in
temperature of exhaled breath compared to ambient air temperature. Oxygen electrode discs are
particularly sensitive to temperature and will show an increase in signal as a result. Since the
temperature increase is only temporary, the oxygen signal will fall after a short time.
After the temperature related signal increase, a steep drop in signal is observed due to decreased
oxygen levels in exhaled breath (approx 17%). The signal should the begin to return to the original
level as the ambient oxygen begins to equilibrate around the electrode disc.
If the observed signal is not as shown above, it may be caused by an inadequate electrode
preparation or worst case, a problem with the disc itself. Try cleaning the disc and re-preparing
before repeating the test described above. If problems still occur, please contact Hansatech
Instruments.

Once this test has been completed satisfactorily, mount the disc into the base of the electrode
chamber. An additional test may be carried out in order to test the response of the disc in situ.
Please refer to the Operating the Magnetic Stirrer section for further details.

mailto:info@hansatech-instruments.com
mailto:info@hansatech-instruments.com


16 Oxygraph +

© 2019 Hansatech Instruments Ltd

1.3.3 Electrode Disc Cleaning

1.3.3.1 Electrode Disc Maintenance

Although the oxygen electrode disc is one of the smallest components of an oxygen measurement
system, it is the most crucial component of the system. Therefore, maintaining the disc to a high
standard is extremely important. A significant proportion of technical support requests received by
Hansatech Instruments Ltd relate to oxygen electrode disc performance. Of these requests, the
vast majority are the result of failure to comply with recommended working practices and
maintenance procedures. Some of the more common abuses of electrode discs include:

Failure to Maintain Electrode Disc

If the electrode disc is not maintained sufficiently, deposits of silver chloride (soft brown deposit)
and/ or silver oxide (hard black deposit) will build up on the silver ring (anode) of the disc. In the
image below, deposits of black silver oxide can clearly be seen on the silver anode of the left
electrode disc. By contrast, the electrode disc on the right has a well maintained, clean anode.
The formation of silver chloride is normal and desirable in small quantities as it is an electrical
conductor and therefore improves the stability and sensitivity of the electrode disc. It is easily
removed by cleaning and will reform when the electrode is next polarised. However, deposits of
black silver oxide are to be avoided. Silver oxide is an electrical insulator and its formation will
reduce the available surface area of the silver anode and result in a dramatic reduction or
complete loss of electrode signal. The electrode disc should be maintained in accordance with our
recommended procedure. Please refer to the Electrode Cleaning section.

This image shows a typical case of poor maintenance. The disc has not been cleaned after use
and was not stored in a sealed container with desiccant away from strong sunlight. As a
consequence, the epoxy resin has become prematurely discoloured due to a combination of strong
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sunlight and absorption of moisture from the environment. The silver anode is almost entirely
covered with a deposit of black silver oxide. The platinum stud and dome are both dirty and badly
scratched. This will cause an uneven layer of electrolyte beneath the membrane during
measurement leading to unstable and unresponsive signals. This disc is beyond economic repair.

In contrast, this disc has been maintained according to our recommendations and has been stored
correctly in an air tight container with desiccant. The epoxy resin is clear, the silver anode is
smooth and polished and the platinum cathode is scratch free. The area of the electrode dome
surrounding the cathode is also free from abrasions and pits across the entire surface. An
electrode disc, when kept in this kind of condition will provide years of high quality measurements

Disc is Left to Dry Out After Use

With the electrode disc un-polarised, the KCl electrolyte dries out quickly in air and begins to
crystallise. KCl is quite aggressive and will, by capillary attraction, deposit in any minor crevice. If
the electrode is left to dry out several times, it is possible that the KCl will finally break down the
seal between either of the metal electrodes and the epoxy resin surround and seep into the
fissure formed where it will crystallise to further expand the fissure.
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This is most likely to occur between the platinum cathode and epoxy resin dome and regrettably
will cause most damage at this point. Damage to the electrode can be observed under low power
microscopy (x10 magnification) as a broad white collar around the neck of the platinum as shown
in the image above. The effect of this will be to cause instability and drift of the electrode signal
and a large increase in the level of electrical signal observed in zero oxygen (residual current).
This will have the effect of reducing the ability of the electrode to measure small changes in
oxygen flux and will eventually render the electrode unserviceable and beyond economic repair.
The disc will require replacement. 

After use, the electrode disc should be stripped down, cleaned carefully according to our
recommended procedures and stored in a dry, air-tight container with added desiccant.

It is possible to leave electrode discs in liquid-phase systems prepared over-night PROVIDED it
remains polarised and is left mounted in the electrode chamber with stirred air-saturated water in
the reaction vessel. In gas-phase measurements, the electrode is likely to dry out more rapidly and
we would recommend stripping down, cleaning and storing the electrode after each measurement
day.

Cleaning with Unsuitable Materials

Hansatech Instruments Ltd offer the S16 cleaning kit for maintenance of the oxygen electrode
disc. The kit contains special cleaning pastes which are recommended for optimal electrode
performance.
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In the absence of this kit, users have resorted to cleaning the electrode with various abrasive
compounds including commercial metal polishes or smoker's toothpastes etc. We would caution
against the use of inappropriate materials as they may cause irreversible damage to the
electrode. Some metal polishes are harmful to the disc as they can contain an ammonia base or
solvent additive. These substances can cause irreversible poisoning to the platinum cathode and
could also cause significant damage to the epoxy resin. Excessive cleaning with abrasive
substances can badly scratch and alter the profile of the electrode dome which may cause an
uneven layer of electrolyte across the cathode leading to instability, drift and lack of
responsiveness of the oxygen signal. The S16 electrode cleaning kit is supplied with all Oxygraph
and Oxytherm Systems and can also be obtained by contacting us directly. Details of the cleaning
procedure can be found in the Cleaning Procedure section.

1.3.3.2 Cleaning the Electrode Disc

Periodic maintenance is required if you are to maintain your electrode in good condition. It should
be cleaned after use and before prolonged storage. It is particularly important that the electrode is
never left to dry out with electrolyte in place, as crystallisation of electrolyte may cause the
platinum/epoxy resin seal to be breached and crystalline electrolyte to be deposited around the
cathode. If this occurs, the electrode will become rapidly unserviceable and will require
replacement. Cleaning is best achieved by following the procedure outlined below. (An electrode
maintenance kit -ordering code S16- containing the items described is available. Please contact
Hansatech Instruments for further details). It is important to use the correct polishing agent as
harsh abrasive substances will damage the resin in which the electrodes are set. It should also be
noted that many commercial metal polishes contain ammonia or solvents which may cause
irreversible poisoning of the platinum cathode.

Cleaning Procedure

Silver Anode
The silver electrode (anode) is subject to electrochemical deposition of chloride and oxide salts
during use. This typically manifests as a brown/black deposit which forms on the surface of the
Silver. Whilst deposition of small amounts of brown Silver Chloride is normal and desirable,
excessive deposits or deposits of black oxides will cause a rapid deterioration in electrode
performance and may result in lower signal levels, signal drift and increased signal noise. Select a
small cotton bud from the maintenance kit. Cotton buds vary a little in size, so check to see that
the diameter of the cotton bud will allow it to be fully inserted into the well of the electrode, thus
allowing contact with the silver electrode in the base of the well. If the bud is a little large,
carefully reduce the size of the cotton bud by removing a layer of cotton wool from the tip until the
bud will fit the well. Moisten the bud with a little distilled water. Apply a small amount of either
the Rapid Hansatech Polishing paste to the tip of the bud. Insert the bud into the well of the
electrode and gripping the bud just above the tip, apply moderate pressure and gently rotate the
bud around the electrode well in a circular motion 6 - 10 times. Observe the Silver anode. Continue

mailto:info@hansatech-instruments.com
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to gently polish the silver electrode until all brown or black deposits on the surface of the silver
are removed and the surface of the silver is highly polished.

Platinum Cathode
The platinum cathode is not subject to such deposition and all that is necessary is to maintain a
scratch-free highly polished finish using the procedure outlined below. Apply a small amount of
the Rapid Hansatech Polishing paste (revised cleaning kits supplied from 01/10/01) or the No. 2
Fine Hansatech Polishing paste (earlier 2 part cleaning kits with Coarse and Fine pastes) to the
unused end of the cotton bud moistened with a little distilled water , or if preferred to a small
piece of moist cotton wool. Now, using a circular motion, gently polish the platinum cathode
located in the centre of the electrode dome. It is important to restrict the polishing motion to the
platinum and avoid as much as possible contact with the epoxy resin surrounding the platinum.
Excessive polishing of the cathode area is to be avoided as this will eventually lead to a change of
curvature of the electrode dome, which will result in deterioration of electrode performance. When
finished, the platinum cathode should have a “mirror finish”. If the surface of the platinum has
become scratched, repeat the above procedure using the Rapid Hansatech Polishing paste
(revised cleaning kits supplied from 01/10/01) or first using the No. 1 Coarse Hansatech Polishing
paste, followed by the No. 2 Fine Polishing paste (earlier 2 part cleaning kits with Coarse and Fine
pastes).

1.3.3.3 Electrode Disc Rinsing, Drying & Storage

Rinsing & Drying
Once the electrodes have been satisfactorily cleaned, it is important to remove all traces of the
polishing paste from the electrode surfaces by rinsing the electrode with a small volume of
distilled water whilst gently scrubbing these areas with a soft bristled brush. (A toothbrush is
ideal). Avoid wetting the electrical connector of the disc during this procedure. Dry the electrode
thoroughly using paper towel.

Storage
Store the electrode, when not in use, in an air-tight container along with a suitable desiccant such
as Silica gel. Periodically replace or rejuvenate the desiccant.

1.3.3.4 Leaving the Electrode Disc Polarised Overnight

At the end of a day's experiments, care of the used equipment not only constitutes good
laboratory practice but is also crucial to the longevity of the equipment, particularly the electrode
disc. Once the experiments are finished, there are 2 procedures that may be followed to ensure
that the disc is kept in good working condition:

Apparatus is dismantled
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The reaction mixture and magnetic follower (or leaf disc and supports in gas phase
measurements) should be removed from the electrode chamber. Any hazardous substances should
be disposed of according to any COSHH guidelines in practice in the lab. The disc should be
removed from the chamber base and disconnected from the electronics.

Carefully remove the smaller O-ring, membrane and spacer paper with a pair of forceps paying
particular attention to not scratching the electrode dome. An uneven surface across the dome
results in an uneven layer of electrolyte leading to unstable oxygen signals in future
measurements. 

The disc should be rinsed thoroughly with deionised water and dried (avoiding contact with the
electrode cable connection in the case of Oxygraph+ users. Using the S16 cleaning kit (supplied)
and following the guidelines set out in the Electrode Cleaning and Maintenance section of this
document, clean the silver anode of the disc in order to remove any silver oxide (black deposit) or
silver chloride (brown deposit) which may have tarnished the silver during the electrochemical
reactions that occur during polarisation.

Once thoroughly cleaned and rinsed, the disc should be placed in an air tight, desiccated
container and stored away from direct sunlight until needed.

Apparatus remains polarised

It is feasible to leave the disc set up over night if measurements are to continue the following day.
However, strict guidelines must be observed in order to prevent irreversible damage to the
electrode disc. Please note that the following procedure is only suitable for liquid-phase
measurements. 

Once the final measurement of the day is complete, remove any reaction mixture from the
chamber and replace with approx 1.5ml of deionised water. 

Replace the magnetic follower and set the stirrer to On. It is important to leave the disc polarised
in stirred, deionised water if the disc is to be left overnight in order to prevent the disc from drying
out. The effects of drying out are described in the Electrode Cleaning and Maintenance section of
this document. 

When starting measurements again the following day, it is advisable to re-check the disc
calibration by first adding a sample of air-saturated deionised water and ensuring that the oxygen
signal compares to the Oxygen Calibration Table published by Truesdale & Downing (Nature
173:1236, 1954), followed by adding sodium dithionite or bubbling nitrogen gas into the reaction
chamber in order to check the zero oxygen line. 

If the steps described above indicate the disc preparation is still in a good condition,
measurements may continue. However, if the measured signals show deviations in the expected
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signals, it is advisable to either recalibrate or in some circumstances, it may be necessary to
dismantle the disc for cleaning purposes and re-preparation.

1.4 DW1 Oxygen Electrode Chamber

1.4.1 Introduction

1.4.1.1 Introduction to the DW1

The DW1 oxygen electrode chamber provides a versatile solution to measurements of dissolved
oxygen in liquid-phase. It can be used for a wide range of applications from basic teaching
through to more advanced research assays. However, due to the gas-tight plunger assembly, the
DW1 lends itself particularly well to respiration assays in small sample volumes where any minute
diffusion of ambient oxygen into the chamber may cause measurement artifacts. The DW1 is also
suitable for gas-phase samples.

The DW1 oxygen electrode unit is constructed from clear cast acrylic providing good sample
visibility & uniform illumination. Precise temperature control of the sample and electrode disc can
be achieved by connecting the water jacket of the DW1 to a thermoregulated circulating water
bath. The sample is housed within a borosilicate glass reaction vessel which has a variable
sample volume of between 0.2 and 2.5ml controlled by the gas-tight adjustable plunger assembly.
This plunger has a stoppered central precision bore allowing additions/subtractions to be made
to/from the reaction mixture using a standard Hamilton type syringe. A prepared S1 electrode disc
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is mounted in the bottom of the DW1 electrode chamber allowing the dome of the disc to form the
floor of the reaction vessel itself.

Minimum chamber volume : 0.2 ml
Maximum chamber volume : 2.5 ml

1.4.1.2 Features of DW1

A - Lugs for A2 top plate key (see instructions on disassembly of DW1)
B - Top plate
C - Water jacket to circulating water bath connectors
D - Borosilicate glass reaction vessel
E - Base ring
F - Water Jacket
G - Standard plunger assembly
H - Gas tight plunger assembly (supplied with DW1/AD)
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1.4.1.3 DW1 Transmission Properties

The water jacket of DW1 is constructed from cast acrylic to ensure good transmission of
photosynthetically active radiation (PAR) allowing external light sources to be used in
photosynthesis studies. The borosilicate glass reaction vessel also transmits throughout the PAR
(400 - 700 nm) wavelengths.

The figure above represents transmission profiles of 10 mm thickness Acrylic (-) and borosilicate (-
- -) across ultra violet (UV), photosynthetically active radiation (PAR) and infrared (IR)
wavelengths.

1.4.1.4 DW1 Plunger Assembly

Diffusion of atmospheric oxygen into the reaction vessel is prevented by the plunger assembly.
This assembly can be adjusted using the screw thread to give a variable reaction vessel volume of
0.2 - 2.5 ml. The capillary hole in the plunger allows sampling and additions to be made to the
reaction mixture via a Hamilton syringe with minimal atmospheric oxygen diffusion into the
reaction vessel.

An optional gas tight plunger provides an O ring seal between the plunger itself and the inner wall
of the glass reaction vessel. A central stopper is also provided to plug the central bore in the
plunger. This stopper should not be fitted until the plunger height has been correctly adjusted.
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After adjustment of the plunger assembly to the desired height, the stopper may be refitted to the
central bore. Once fitted the plunger assembly provides a gas-tight seal which allows the DW1
chamber to be used for gas-phase measurement, or used in combination with special equipment
for hydrogen measurement (please ask for details). The plunger assembly also allows
measurements to be made on very small reaction volumes (less than 0.5ml approx.).

1.4.2 Setting up the DW1

1.4.2.1 Installing the S1 Electrode Disc in an Electrode Chamber

Before installing the electrode disc into the chamber, it should be correctly prepared according to
the guidelines set out in the Electrode Preparation section.

Once the disc has been prepared and suitably tested, it is now ready to be installed in the
electrode chamber.

Remove the base ring from the electrode chamber and place the prepared electrode disc onto the
top

Offer the base ring and disc assembly up into the underside of the main body of the electrode
chamber so that the electrode cable connection fits with the key way on the chamber base thread.
Gently hold the base in position while threading the base ring onto the electrode chamber so that
it is slightly more than finger tight.

It is important not to over-tighten the base ring as this will cause the membrane to stretch over
the electrode dome. During measurement, when the membrane starts to relax, the measured
signal will drift.

Ensure that the electrode remains polarised in order to prevent the electrode from drying out
whilst other preparations are made prior to measurement.

1.4.2.2 Temperature Control

Introduction to Temperature Control

All experimental assays will have an optimum temperature at which the sample will be most
efficient in either evolving or consuming oxygen and it is important that this experimental
temperature is maintained at all times throughout the duration of the experiment. This includes
ensuring that any additions to be made to the reaction vessel during the experiment are pre-
equilibrated to the assay temperature before being added.
According to the studies of G.A. Truesdale and A.L. Downing (The solubility of oxygen in water,
1954, Nature 173: 1236), at any given temperature and atmospheric pressure, air saturated, de-
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ionised water contains a known concentration of dissolved oxygen which may be calculated
mathematically.

Oxygen concentration in a liquid decreases as temperature increases which is why it is important
that the assay temperature is established for both the sample and any additions prior to the
commencement of the experiment. However, in addition to this effect, the oxygen electrode disc
itself is also sensitive to temperature.

The electrode disc signal increases with an increase in temperature. In assays where higher
temperatures are used (such as mitochondrial respiration studies), it is recommended that the
disc is fully equilibrated to the assay temperature before any calibration or measurement takes
place. This can take up to 15 minutes.

Therefore, it is not just liquid-phase measurement systems that are temperature critical; gas-
phase systems are equally susceptible to fluctuations in temperature.

The assay temperature needs to be decided as one of the initial considerations of the experiment
as the apparatus is calibrated based on a specified temperature. With the exception of the
Oxytherm Peltier chamber, all other liquid and gas-phase electrode chambers provide temperature
control to the sample and disc via a water jacket which encapsulates the reaction / sample vessel.
In liquid-phase systems, the vessel is constructed from borosilicate glass allowing an efficient
heat transfer between the circulating water and the sample, thus maintaining effective
temperature control.
In gas-phase electrode chambers, the sample is separated from the circulating water by a quartz
window which also provides an effective thermal transfer. The water jacket should be connected,
using the plastic connectors provided, to the flow and return tubes from a thermoregulated
circulating water bath.

In DW1, DW1 and DW3 electrode chambers, connect the flow tube to the lower water jacket
connector and the return tube to the upper water jacket connector. This ensures that a fresh
supply of water is constantly flowing around the DW1 water jacket and assists in dispersing any
air bubbles which will rise naturally to the upper outlet port. In all other electrode chambers, the
water jacket connectors are on the same plane so flow/return tubes may be connected to either
connector.

The tubing lengths between the circulator and the electrode chamber should be kept minimal in
order to maintain good temperature control. A circulator providing a flow rate of 6 litres/min or
more is recommended. Although the water jacket gives more positive control of sample
temperature than many systems in which control is effected entirely by circulated air, it is, like
them, entirely incapable of rapidly dissipating heat generated within the chamber by light
containing a large infra-red component. Appropriate filters (water, copper sulphate solution,
interference filters, heat-reflecting mirrors etc) should therefore be employed when using a light
source. Light saturation without heating is, of course, extremely difficult to achieve but the fact
that the electrode is itself very responsive to small changes in temperature provides an easy
method of checking the effectiveness of any light filtering system which is employed.
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Halogen white light sources such as the Hansatech LS2 and the discontinued FLS1 light source
produce a significant amount of heat. These light sources were fitted with an infra-red reducing
hot-mirror filter in order to reduce the heating effect of the light source. All current Hansatech
light sources contain LED emitters which produce significantly less heat output.

Temperature Effects on Liquid-Phase Samples

According to the studies of G.A. Truesdale and A.L. Downing (The solubility of oxygen in water,
1954, Nature 173: 1236), at any given temperature and atmospheric pressure, air saturated, de-
ionised water contains a known concentration of dissolved oxygen which may be calculated
mathematically.

This data is based on measurements of dissolved oxygen in water at the given temperature and
standard atmospheric pressure published by Truesdale & Downing (Nature 173:1236, 1954).

The formula used in calculating the oxygen values in the table is as follows:

Cs=14.16 - (0.394 * T) + (0.007714 * T^2) - (0.0000646 * T^3)

(Where Cs is the oxygen saturated concentration in ppm and T is temperature in °C)

1 ppm is equivalent to

1µg/ml or (1µg/32g/mol) = 0.03125 µmol/ml or 31.25 nmol/ml
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Temperature Effects on the Electrode Disc

The electrode disc signal increases with an increase in temperature. Therefore, the response from
the disc opposes that of the oxygen signal at different temperatures. In assays where higher
temperatures are used (such as mitochondrial respiration studies), it is recommended that the
disc is fully equilibrated to the assay temperature before any calibration or measurement takes
place. This can take up to 15 minutes and can be observed as follows:

· Prepare the electrode disc and mount correctly into the base of the electrode chamber. For
liquid-phase chambers, add a 1ml, stirred sample of air-saturated, de-ionised water that is pre-
equilibrated to the experimental temperature to the chamber.

· Connect the water jacket(s) of the electrode chamber to the supply from the circulating water
bath (Refer to Setting Up Temperature Control section for more information).

· Begin a recording from the electrode disc and observe the oxygen signal. If the experimental
temperature is high (e.g. 32°C), the signal from the electrode disc will initially rise due to the
temperature sensitivity of the disc.

· Once the disc begins to equilibrate to the temperature, the signal will begin to decline as the
higher temperature effect on the sample is opposite. Once the signal from the disc has re-
stabilised, the disc is equilibrated to the assay temperature and calibration may be performed.

1.4.2.3 Sample Stirring

Electrochemical reactions taking place at the cathode of the electrode disc require the
consumption of oxygen in order to produce an electric current. This current is then digitised by an
electrode control unit and presented as a chart recorder emulation in the OxyTrace+  software.

The nature of this process means that as oxygen is continuously consumed at the cathode, an
oxygen depleted layer is produced immediately above the cathode. As the rate of consumption by
the disc is greater than the rate of oxygen diffusion through liquid, the measured signal from the
electrode disc will continuously decrease during measurement. This problem is overcome by
continuously stirring the sample in order to replenish the depleted layer at the cathode and to
ensure that the dissolved oxygen within the sample is kept evenly distributed throughout the
reaction vessel.

The magnetic stirrer is an integral feature of the electrode control unit and is located on the top of
the system. Stirring of the sample is achieved by placing a magnetic follower or "Flea" into the
reaction vessel itself. Activating the stirrer rotates the magnet beneath the stirrer cap at user
definable speeds of between 150 and 900 RPM. The flea tracks the magnetic stirrer, rotating just
above the cathode of the electrode so as not to cause any damage to the membrane preparation.
2 types of flea are available:

PTFE coated magnet
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This is the standard flea supplied with the systems. It consists of a small magnetic bar coated in
PTFE.

Glass flea
Glass fleas consist of several fine strands of iron sealed into a thin glass capillary tube.
Each type of flea has advantages and disadvantages of use. For example, for experiments where
very small changes in oxygen tension are to be measured, some users prefer the glass fleas as
PTFE is known to absorb a very minute amount of oxygen. In the large majority of applications
however, this absorption is not an issue. Glass fleas are not magnetic themselves so they are not
as reliable at tracking the rotating magnet in more viscous samples Therefore, the maximum
speed of stirring would be lower than that of the PTFE coated flea. The effects of the oxygen
depleted layer can be clearly seen by performing a short experiment:
Prepare the electrode disc and mount it into the base of the electrode chamber.

· Place the chamber on top of the magnetic stirrer.
· Add 2ml of air-saturated, de-ionised water into the chamber and drop a flea into the sample.
· Open the stirrer control window as described above and set the stirrer to a speed of 75%.
· Start a recording and allow the trace to stabilise.
· Once the trace has stabilised, stop the stirrer. The signal will start to decline steadily.
· Re-start the stirrer. The signal will return to it's original level.

The screenshot below shows how the trace should respond to the procedure outlined above.
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1.4.3 Care and Maintenence

1.4.3.1 Electrode Chamber Disassembly

The following guidelines detail the dismantling, cleaning and subsequent re-assembly of the DW1
electrode chamber. However, the general principles of the disassembly procedure may also be
followed for the DW2/2 electrode chamber.

The Oxytherm+ Peltier Electrode Chamber and DW3 electrode chambers have very different
cleaning and reaction vessel replacement procedures and the following guidelines do not apply to
these products.
The electrode chamber should be periodically dismantled and thoroughly cleaned in order to
maintain good working order as particulates in the coolant will gather in the water jacket and
obscure light transmission. It is also possible that after several years use, the 2 O-rings which seal
the reaction vessel from the water jacket may perish causing leaks.

Follow the instructions below to disassemble DW1 for cleaning.
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The DW1 is supplied as standard with a top plate key and alignment jig (Cat. no. A3) was included
with the DW1. This kit is used to remove the top plate of the chamber so that the reaction /
sample vessel may be safely removed for cleaning and the inside of the water jacket can be
cleaned.

Remove the electrode disc (if present) from the base of the electrode chamber, remove the
plunger assembly and insert the alignment jig fully into the reaction vessel from the top of the
electrode chamber. The alignment jig is critical during re-assembly of the electrode chamber as it
ensures that all the components are aligned correctly when the top plate is attached.
The top plate key has 2 metal pins on the underside which locate into 2 indentations on the top
plate of the electrode chamber. The key is now directly above the alignment tool thus allowing the
top plate to be gently unscrewed in an anti clockwise direction. The initial loosening of the top
plate may be difficult as the top plate is sealed to the main body of the electrode chamber with an
O-ring.

Once the top plate is completely unscrewed, it can be lifted away from the main body of the
electrode chamber along with the glass reaction vessel. Carefully remove the reaction vessel from
the alignment jig. Remove the small O-ring on the top plate which seals the reaction vessel to the
top plate. There is also another O-ring in the bottom plate of the electrode chamber which serves
the same purpose at the bottom of the reaction vessel.
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Once the top plate has been removed the components can be extracted and cleaned with a mild
detergent or replaced as necessary. (A list of spares and replacement part catalogue numbers is
given in the DW1 Spare Parts section).
Some applications use powerful respiratory inhibitors such as Rotenone which can prove very
difficult to completely remove from the internal walls of the reaction vessel which can lead to
unwanted contamination of subsequent samples. Conventional cleansing methods, as described
above, may prove ineffective and an alternative method is required.

Although Ethanol is widely considered to be an effective solvent in the removal of Rotenone from
the reaction vessel:

HANSATECH INSTRUMENTS STRONGLY CAUTIONS AGAINST THE USE OF THIS SUBSTANCE AS ANY
SPILLAGE ON TO THE ACRYLIC PARTS OF THE DW1 WILL CAUSE IRREVERSIBLE DAMAGE TO THE
MAIN BODY OF THE CHAMBER. ORGANIC SOLVENTS SUCH AS ETHANOL WILL REACT WITH THE

ACRYLIC CAUSING FRACTURING.

Through experience, the most desirable solution has been to use a separate reaction vessel when
performing applications utilising Rotenone and other respiratory inhibitors. A pack of 2 spare
reaction / sample vessels are supplied as standard with the DW1. However, further spares (S3)
can be obtained from Hansatech Instruments (or relevant International Distributor). Alternatively,
if possible, reserve a DW1 chamber specifically for use with Rotenone.

Once all the individual components have been cleaned/replaced, re-assemble the electrode
chamber following the disassembly instructions in reverse.
When replacing the O-rings at the top and bottom of the reaction vessel, it is critical to ensure
that the correct O-rings are used in the correct place. The O-ring at the top of the reaction vessel
is fractionally larger than the bottom O-ring. Failure to use the correct O-rings will cause leakage
of circulating water from the water jacket into the reaction vessel and contaminating the sample.
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If the reaction vessel is misaligned when the chamber is fully re-assembled, the plunger assembly
will not fit into the chamber and in worst cases, the reaction vessel could crack as the top plate is
tightened. It is therefore important to ensure that the reaction vessel, O-rings and top and bottom
plates are correctly aligned using the alignment jig when re-assembling the electrode chamber.

1.4.3.2 DW1 Spare Parts

The following list shows the catalogue numbers for all necessary spare parts and components for
the DW1 electrode chamber. Please contact Hansatech Instruments for further information.

mailto:info@hansatech-instruments.com
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A: Plunger screw
Part No. 820024

(with O-ring)
Part No. 820027

G: Base ring
Part No. 820023

B: Plunger nut
Part No. 820025

H: Water jacket and bottom plate
Part No. 941020

C: Reaction vessel
Part No. S3, pack of 2

I: Water jacket connectors
Part No. 820026, 2 required

D: Magnetic follower
Part No. S2/P or S2/G

J: Top plate
Part No. 820021

E: Base plate O-ring
Part No. S5

Plunger bore stopper
Part No. 739035

F: Electrode disc
Part No. S1  

1.4.4 Modifications

Plunger Modifications

Diffusion of atmospheric oxygen into the reaction vessel is controlled by the plunger which can be
adjusted using the screw thread to give a variable reaction vessel volume of 0.2 - 2.5 ml. The
capillary hole in the plunger allows sampling and additions to be made to the reaction mixture via
a Hamilton syringe with minimal atmospheric oxygen diffusion into the reaction vessel.

The DW1 electrode can be optionally supplied with an adapted plunger assembly (DW1/AD). The
plunger is modified to provide an O ring seal between the plunger and the glass reaction vessel. A
central stopper is also provided to plug the central bore in the plunger. This stopper should not be
fitted until the plunger height has been correctly adjusted. After adjustment of the plunger
assembly to the desired height, the stopper may
be refitted to the central bore. Once fitted the plunger assembly provides a gas-tight seal which
allows the DW1 chamber to be used for gas-phase measurement, or used in combination with
special equipment for hydrogen measurement (please ask for details). The adapted plunger
assembly is also recommended when measurements are made on very small reaction volumes
(less than 0.5ml approx.).
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1.5 Oxygraph + Electrode Control Unit

1.5.1 Setting up the Oxygraph +

1.5.1.1 Oxygraph Plus Electrode Control Unit

Connections to the Oxygraph+

Before making any measurements, it is important that the system is set up correctly.

USB
The diagram below shows the various connections of the USB control unit.

Connecting the USB unit

1. Ensure that the 12V power is connected to the 12V input socket on the control panel.
Confirmation that this connection has been made is shown by the power symbol on the front
illuminating every 10 seconds.

2. Connect the USB cable to any available USB ports on the PC. Connect the other end of the USB
cable to the USB connection on the the rear of the control unit. If more than 1 unit is to be
used, repeat the process with the unit and additional USB cables.

3. Connect the prepared electrode disc to the control unit via the electrode connection cable.
4. if any auxiliary signal is to be recorded, users will require to connect the auxiliary device to the

rear of the control unit via a Mini-DIN, BNC or 2mm connector.
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1.6 OxyTrace + Software

1.6.1 Startup

1.6.1.1 OxyTrace + Software Initialisation

This section assumes that the OxyTrace+ software has been successfully installed on your PC and
that all the necessary connections have been made between the electrode control unit and the PC
with the control unit powered up.
Run the OxyTrace+ software by double clicking the desktop icon that was created during
installation or by selecting OxyTrace+ from the Hansatech Instruments Ltd program group in the
Windows Start Menu. If no control unit is located, the following dialogue box will be generated by
the OxyTrace+ software.

If you see this dialogue box displayed with empty values for Model, Serial No etc, please ensure
that you have correctly connected the control unit to the PC and that it is powered up with  a blue
status indication light on the front panel of the control unit. When this been confirmed, press OK
to close this dialogue and then select Hardware > Scan for Instruments. You will then see the
following dialogue compete with information regarding the connected control unit such as serial
number and calibration status. Press OK to continue.
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If communications with the control unit cannot be established, please refer to the Communication
Problems between Control Unit and the PC section for further information

1.6.1.2 Testing the Electrode Disc Response

Once the electrode disc has been correctly prepared, it is advisable to check the response of the
disc prior to mounting the disc within the electrode chamber.

Before proceeding, you will need to ensure that the electrode control unit you are using is
correctly connected to the PC and that it is communicating with the OxyTrace+  software. If you
are experiencing problems with communications between the control unit and software, please
refer to the Software Initialisation section of this document.

To check the response, connect the electrode disc to the rear of the control unit at the electrode
input using the S1/ADL electrode connection cable. Start a recording. The signal will initially be
extremely high and displayed as nanoamps (nA) and will take a few minutes to stabilise at an air
line level. A new or well maintained disc should read approx. 1600 nA in air but this may vary
between ±240nA.

Once the electrode signal is stable, breathe exhaled air across the disc and observe the reaction
on the graph screen. The signal should be plotted as in the diagram below.
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The first deviation in signal after breathing across the disc is induced due to a large increase in
temperature of exhaled breath compared to ambient air temperature. Oxygen electrode discs are
particularly sensitive to temperature and will show an increase in signal as a result. Since the
temperature increase is only temporary, the oxygen signal will fall after a short time.

After the temperature related signal increase, a steep drop in signal is observed due to decreased
oxygen levels in exhaled breath (approx 17%). The signal should the begin to return to the original
level as the ambient oxygen begins to equilibrate around the electrode disc.

If the observed signal is not as shown above, it may be caused by an inadequate electrode
preparation or worst case, a problem with the disc itself. Try cleaning the disc and re-preparing
before repeating the test described above. If problems still occur, please contact Hansatech
Instruments.

Once this test has been completed satisfactorily, mount the disc into the base of the electrode
chamber. An additional test may be carried out in order to test the response of the disc in situ.
Please refer to the Operating the Magnetic Stirrer section for further details.
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1.6.2 OxyTrace + Workspace

1.6.2.1 Menu Bar

File Menu

· New
Creates a new document
· Open
Opens an existing file
· Overlay
Overlay's an existing file on to the same axes as the file currently loaded
· Save
Saves the current file
· Save As
Specify a new filename for the current file
· Print
Prints the current file. The printout will reflect whichever method of data display is currently
active. For example, if the tabulated data display mode is selected, this is what will be printed
· Print Preview
Shows a preview of how the current file view will be printed
· Print Setup
Opens the Windows printer settings dialogue
· Recently Opened Files
Displays a list of the most recently opened files
· Exit
Closes the program

Hardware Menu

When an Oxygraph+ control unit is connected to OxyTrace+ , the Hardware menu is presented as
follows:

· Start Recording
Begins recording the oxygen signal from the S1 electrode and any auxiliary input that is
configured. 

· Stop Recording
Stops the current recording. 

· Channel Configuration
Opens the Instrument Summary dialogue 

· Acquisition Rate
Opens the Data Acquisition Rate dialogue. 
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· Stirrer Speed
Opens the Sample Stirring Dialogue

· Setup NEW PFD Table
   Opens the PFD (Photon Flux Density) table to allow experimental light intensity steps to be
defined and executed. Please refer to the Configuration of PFD table section for further
information
· Scan for Instruments

This tool is prompts OxyTrace+  to scan the PC com ports for a connected Oxygraph control unit.
Use this tool when adding additional Oxygraph control units to a multi-channel chain or when
requiring a connected control unit after having selected View Files at the Software Initialisation
dialogue. 

· Instrument Test
Opens the Instrument Test dialogue for control unit diagnostic features. 

When an Oxytherm+ control unit is connected to OxyTrace+ , the Hardware menu is presented as
follows:

· Start Recording
Begins recording the oxygen signal from the S1/MINI electrode and any auxiliary input that is
configured. 

· Stop Recording
Stops the current recording. 

· Channel Configuration
Opens the Instrument Summary dialogue 

· Acquisition Rate
Opens the Instrument Summary dialogue allowing the rate that the control unit measures
oxygen from the electrode disc to be configured. 

· Stirrer Speed
Opens the Sample Stirring Dialogue. 

· Temperature Control
Opens the Peltier Chamber Temperature dialogue to set Oxytherm temperature control. 

· Temperature Record
Logs the measured temperature of the Peltier Chamber. Temperature values are presented in
the Tabulated Data view. 

· Actinic Light Control
   Allows the configuration of the actinic light within the Oxytherm+
· Chamber Viewing Light

Presents to option to enable or disable the Oxytherm+ viewing light
· Setup NEW PFD Table
   Opens the PFD (Photon Flux Density) table to allow experimental light intensity steps to be
defined and executed. Please refer to the Configuration of PFD table section for further
information
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· Scan for Instruments
This tool is prompts OxyTrace+  to scan the PC com ports for a connected Oxytherm+ control
unit. Use this tool when adding additional Oxytherm+ control units to a multi-channel chain.

· Instrument Test
Opens the Instrument Test dialogue for control unit diagnostic features. 

When an Oxylab+ control unit is connected to OxyTrace+ , the Hardware menu is presented as
follows:

· Start Recording
Begins recording the oxygen signal from the S1 electrode and any auxiliary input that is
configured. 

· Stop Recording
Stops the current recording. 

· Channel Configuration
Opens the Instrument Summary dialogue. 

· Acquisition Rate
Opens the Instrument Summary dialogue. 

· Stirrer Speed
Opens the Sample Stirring Dialogue. 

· Temperature Record
Logs the measured temperature of the Peltier Chamber. Temperature values are presented in
the Tabulated Data view. 

· Light Control
Opens the Light Source Control dialogue which allows the attached light source to be set to a
given intensity. Please refer to the Manual Control of Light Source section for further
information. 

· Setup NEW PFD Table
Opens the PFD (Photon Flux Density) table to allow experimental light intensity steps to be
defined and executed. Please refer to the Configuration of PFD table section for further
information. 

· Scan for Instruments
This tool is prompts OxyTrace+  to scan the PC com ports for a connected Oxylab control unit.
Use this tool when adding an additional Oxylab control unit to a dual-channel setup or when
requiring a connected control unit after having selected View Files at the Software Initialisation
dialogue. 

· Instrument Test
Opens the Instrument Test dialogue for control unit diagnostic features. 
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Calibrate Menu

Liquid Phase Calibration:

· Air Saturated Water
Begins a standard liquid phase calibration routine using air saturated water as the known
constant.
· Manual
In assays which do not use air saturated water, use this calibration option. You will be
prompted to enter a known oxygen value to reference against the airline stage of the
calibration routine. Please refer to the Manual Calibration Routine for further information.

· Gas Phase Calibration:
When using a gas-phase electrode chamber, use this option to initiate the gas-phase calibration
routine. Please refer to the Gas-Phase Calibration section for further information
· Oxygen Calibration Details
Views the details of any current oxygen calibration. Please refer to the Viewing Oxygen
Calibration Details section for further information
· Set Oxygen Warning Interval
An oxygen calibration warning interval may be set so that after a given number of days post
calibration, the user is prompted that the calibration has expired when the software is initially run.
Please refer to the Set Oxygen Calibration Warning section for further information.
· Calibrate Light - Automatic
When using an Oxylab+ control unit, this begins the automatic calibration routine for connected
light source.  Please refer to the Light Source Calibration section for further information.
· Calibrate Light - Manual
This allows for a light source to be manually calibrated. Please refer to the Light Source
Calibration section for further information.
· Light Calibration Details
Views the details of any current light calibration. Please refer to the Light Source Calibration
section for further information.
· Set Light Warning Level
An light calibration warning interval may be set so that after a given number of days post
calibration, the user is prompted that the calibration has expired when the software is initially run.
Please refer to the Light Source Calibration section for further information.
· Calibrate Auxiliary/pH ISE/Other ISE
Displays the auxiliary channel details and Initialises the Auxiliary Input Calibration routine. Please
refer to the Auxiliary Device Calibration section for further information.
· Aux Calibration Details
Displays the calibration details of connected auxiliary devices. Please refer to the Auxiliary Device
Calibration Details section for further information
· Set Auxiliary warning interval
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An auxiliary calibration warning interval may be set so that after a given number of days post
calibration, the user is prompted that the calibration has expired when the software is initially run.
Please refer to the Set Auxiliary Calibration Warning section for further information.

View Menu

· File Information
Displays general information that saved along with the current file. Please refer to the File
Information section for further information
· Toolbar
Toggles the Toolbar between show/hide
· Status Bar
Toggles the Status Bar at the foot of the screen between show/hide

Graph Menu

· Setup Trace Colours
Allows trace colour and data point marker colours to be customised. Please refer to the Trace
Settings section for further information
· Display Overlaid Traces
Toggles any overlaid traces between show/hide
· Zoom Window
Graph zoom control allowing a selected portion of the trace to be enlarged. Clicking this icon
changes the mouse cursor to cross hairs. Clicking and drag the window to highlight the required
section and click the mouse again to apply the zoom. Please refer to the Axes Settings section for
further information
· Zoom Auto
Graph zoom control which automatically re-sizes the axes to efficiently present all recorded
oxygen and any auxiliary data. Please refer to the Axes Settings section for further information
· Zoom XY
Graph zoom control. Selecting this option opens the Set Axes window allowing oxygen and
auxiliary axes to be scaled by entering in the required from and to values for oxygen, time and
optional auxiliary axes. Please refer to the Axes Settings section for further information
· Zoom Plus
Graph zoom control which increases the zoom based at the center of the graph. Please refer to the
Axes Settings section for further information
· Zoom Minus
Graph zoom control which decreases the zoom based at the center of the graph. Please refer to
the Axes Settings section for further information
· Zoom Undo
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Graph zoom control used to undo the previous zoom command. Please refer to the Axes Settings
section for further information.

Data Bar Menu

When an Oxygraph+ control unit is connected to OxyTrace+ , the Hardware menu is presented as
follows:

· Output
Toggles output level in the data bar between show/hide
· Rate Data
Toggles Live Rate data in the data bar between show/hide.
· Aux Data
Toggles auxiliary device data in the data bar between show/hide
· Small Font
Toggles the font used in the data bar between small and large size

When an Oxytherm+ control unit is connected to OxyTrace+ , the Hardware menu is presented as
follows:

· Output
Toggles output level in the data bar between show/hide
· Rate Data
Toggles Live Rate data in the data bar between show/hide.
· Aux Data
Toggles auxiliary device data in the data bar between show/hide
· Set Temperature
Toggles the set chamber temperature display in the data bar between show/hide
· Actual Temperature
Toggles actual chamber temperature display in the data bar between show/hide
· Small Font
Toggles the font used in the data bar between small and large size
· Flurescence Data
Toggles fluorescence level in the data bar between show/hide

When an Oxylab+ control unit is connected to OxyTrace+ , the Hardware menu is presented as
follows:

· O2 signal mV
Toggles output level in the data bar between show/hide
· Rate Data
Toggles Live Rate data in the data bar between show/hide.
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· Aux Data
Toggles auxiliary device data in the data bar between show/hide
· Light Setting
Toggles the current set light source intensity display in the data bar between show/hide
· Actual PAR Light
Toggles actual current light source intensity reading from the QTP1 sensor in the data bar
between show/hide
· Actual Temperature
Toggles actual chamber temperature reading from the QTP1 sensor in the data bar between
show/hide
· Small Font
Toggles the font used in the data bar between small and large size

Tools Menu

When an Oxygraph+ control unit is connected to OxyTrace+ , the Hardware menu is presented as
follows:

· PFD Setup & Go
Opens the PFD (Photon Flux Density) table to allow experimental light intensity steps to be
defined and executed. Please refer to the Configuration of PFD table section for further
information
· PFD Go
Executes the currently defined PFD table. Please refer to the Configuration of PFD table section for
further information
· QY Graph Setup
Displays the Quantum Yield graph screen configuration options. Please refer to the Quantum Yield
Graph Setup section for further information
· Oxygen Graph 
Displays the graph screen in the data display area. Please refer to the Graph Screen section for
further information
· Oxygen+ Rate Graph
Displays a split screen with the oxygen graph at the lower section and the Live Rate data in the
upper section. Please refer to the Plotting Live Rate Data section for further information.
· Tabulated Data
Displays the tabulated data screen in the data display area. Please refer to the Tabulated Data
section for further information
· Add Event Mark
Adds an event marker to the current recording. Please refer to the Adding Event Marks section for
further information
· Edit Event Marks
Allows event marks on the current file to be edited via the Edit Event Marks dialogue. Please refer
to the Editing Event Marks section for further information



46 Oxygraph +

© 2019 Hansatech Instruments Ltd

· Delete Event Marks
Allows event marks on the current file to be deleted via the Delete Event Marks dialogue. Please
refer to the Deleting Event Marks section for further information
· Options
Opens the Options dialogue allowing general program options to be configured. Please refer to
the Program Options section for further information

When an Oxytherm+ control unit is connected to OxyTrace+ , the Hardware menu is presented as
follows:

· PFD Setup & Go
Opens the PFD (Photon Flux Density) table to allow experimental light intensity steps to be
defined and executed. Please refer to the Configuration of PFD table section for further
information
· PFD Go
Executes the currently defined PFD table. Please refer to the Configuration of PFD table section for
further information
· QY Graph Setup
Displays the Quantum Yield graph screen configuration options. Please refer to the Quantum Yield
Graph Setup section for further information
· Oxygen Graph 
Displays the graph screen in the data display area. Please refer to the Graph Screen section for
further information
· Oxygen+ Rate Graph
Displays a split screen with the oxygen graph at the lower section and the Live Rate data in the
upper section. Please refer to the Plotting Live Rate Data section for further information.
· Tabulated Data
Displays the tabulated data screen in the data display area. Please refer to the Tabulated Data
section for further information
· Add Event Mark
Adds an event marker to the current recording. Please refer to the Adding Event Marks section for
further information
· Edit Event Marks
Allows event marks on the current file to be edited via the Edit Event Marks dialogue. Please refer
to the Editing Event Marks section for further information
· Delete Event Marks
Allows event marks on the current file to be deleted via the Delete Event Marks dialogue. Please
refer to the  Deleting Event Marks section for further information
· Options
Opens the Options dialogue allowing general program options to be configured. Please refer to
the Program Options section for further information
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When an Oxylab+control unit is connected to OxyTrace+ , the Hardware menu is presented as
follows:

· PFD Setup & Go
Opens the PFD (Photon Flux Density) table to allow experimental light intensity steps to be
defined and executed. Please refer to the Configuration of PFD table section for further
information
· PFD Go
Executes the currently defined PFD table. Please refer to the Configuration of PFD table table
section for further information
· QY Graph Setup
Displays the Quantum Yield graph screen configuration options. Please refer to the Quantum Yield
Graph Setup section for further information
· Oxygen Graph 
Displays the graph screen in the data display area. Please refer to the Graph Screen section for
further information
· Oxygen+ Rate Graph
Displays a split screen with the oxygen graph at the lower section and the Live Rate data in the
upper section. Please refer to the Plotting Live Rate Data section for further information.
· Tabulated Data
Displays the tabulated data screen in the data display area. Please refer to the Tabulated Data
section for further information
· PFD Data
Displays the currently defined PFD table in the data display area. Please refer to the Configuration
of PFD table section for further information.
· QY Data
Displays the tabulated data screen in the data display area. Please refer to the Tabulated Data
section for further information
· QY+ Graph Data
Displays a split screen with tabulated data screen plus Graph Data. Please refer to the Tabulated
Data section for further information
· Add Event Mark
Adds an event marker to the current recording. Please refer to the Adding Event Marks section for
further information
· Edit Event Marks
Allows event marks on the current file to be edited via the Edit Event Marks dialogue. Please refer
to the Editing Event Marks section for further information
· Delete Event Marks
Allows event marks on the current file to be deleted via the Delete Event Marks dialogue. Please
refer to the  Deleting Event Marks section for further information
· Options
Opens the Options dialogue allowing general program options to be configured. Please refer to
the Program Options section for further information
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Rate menu

· Setup Live Rate Display
Opens the Setup Live Rate Display dialogue allowing a time interval over which the Live Rate is
calculated in real-time during a measurement. Please refer to the Setup Live Rate Display section
for further information.
· Rate Cursors
Toggles the rate cursors between show/hide. When displayed, 2 rate cursors are presented as
vertical lines on the oxygen axes representing the beginning and end of the rate interval. Please
refer to the Manual Rate Measurements section for further information
· Enter Rate Cursor Times
Allows the start and end points of the rate interval to be defined as an actual time point during the
current file. Please refer to the Manual Rate Measurements section for further information.
· Display Rate Table
Opens the Rates of Change table. This window displays all rates that have been calculated to date
for the current file. Please refer to the Manual Rate Measurements section for further information
· Add Rate to Table
When the rate interval has been defined, use this tool to add the rate calculation to the Rates of
Change table. Please refer to the Manual Rate Measurements section for further information.
· Select Channels
Opens a dialogue which controls which channel signals the rate cursors will take into account
when calculating a rate of change. Options are any of the channels individually or all channels
together. If only 1 channel is present, this selection is obsolete. Please refer to theManual Rate
Measurements section for further information.
· Setup 'Line of Best Fit'
When enabled, the Line of Best Fit automatically draws the best fit slope against the oxygen
signal between the rate interval cursors. This option maybe preferentially enabled to act on
individual channel signals or across all connected channel signals. If the Line of Best Fit is
disabled, the calculation of the rate still happens but the line is not drawn on the graph. Please
refer to the Manual Rate Measurements section for further information.

Help Menu

· Help
Opens this help document
· About OxyTrace+ 
Displays version and copyright information.
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1.6.2.2 OxyTrace + Toolbar

The following tables show the different icons found on the OxyTrace+ toolbar.

Opens an existing file

Saves the current file.

Prints the current file. The printout will reflect whichever method of data display is currently
active. For example, if the tabulated data display mode is selected, this is what will be
printed
Begins recording the oxygen signal from the electrode disc and any auxiliary input that is
configured
Stops the current recording

Opens the Instrument Summary dialogue allowing Oxygen signal to be seen in both nA and
mV as well as displaying legacy units
Opens the Data Acquisition Rate dialogue allowing the rate that the control unit measures
oxygen from the electrode disc to be configured
Magnetic stirrer control. This button has dual functionality depending on options that are
set within the Stirrer Speeds dialogue. If the option "Enable Individual Controls" IS NOT
checked in the stirrer speeds dialogue, this button will simply switch the stirrers or any
connected electrode control units on and off. If the "Enable Individual Controls" options IS
checked, this button will open the Stirrer Speeds dialogue to allow individual control of each
control unit stirrer
This tool is prompts OxyTrace+ to scan the USB ports for a connected control unit. Use this
tool when adding additional control units to a multi-channel chain
Begins a standard liquid phase calibration routine using air saturated water as the known
constant
When using a gas-phase electrode chamber, use this option to initiate the gas-phase
calibration routine. Please refer to the Gas-Phase Calibration section for further information
Displays general information that saved along with the current file. Please refer to the File
Information section for further information
Display the data from the overlaid file as well as the normal file
Toggles the rate cursors between show/hide. When displayed, 2 rate cursors are presented
as vertical lines on the oxygen axes representing the beginning and end of the rate interval.
Please refer to the Manual Rate Measurements section for further information
Graph zoom window control allowing a selected portion of the trace to be enlarged. Clicking
this icon changes the mouse cursor to cross hairs. Clicking and drag the window to
highlight the required section and click the mouse again to apply the zoom. Please refer to
the Axes Settings section for further information
Graph zoom control which automatically re-sizes the axes to efficiently present all recorded
oxygen and any auxiliary data. Please refer to the Axes Settings section for further
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information
Graph zoom control. Selecting this option opens the Set Axes window allowing oxygen and
auxiliary axes to be scaled by entering in the required from and to values for oxygen, time
and optional auxiliary axes. Please refer to the Axes Settings section for further information

Graph zoom control which increases the zoom based at the center of the graph. Please refer
to the Axes Settings section for further information
Graph zoom control which decreases the zoom based at the center of the graph. Please
refer to the Axes Settings section for further information

Graph zoom control used to undo the previous zoom command. Please refer to the Axes
Settings section for further information
Displays the graph screen in the data display area. Please refer to the Graph Screen section
for further information
Displays a split screen with the oxygen graph at the lower section and the Live Rate data in
the upper section. Please refer to the Plotting Live Rate Data section for further information
Displays the tabulated data screen in the data display area. Please refer to the tabulated
data section for further information
Adds an event marker to the current recording. Please refer to the Adding Event Marks
section for further information
Displays version and copyright information

Oxytherm+ Specific Icons (additional to the common icons)
Opens the Peltier Chamber Temperature dialogue to set Oxytherm+ temperature control

Oxylab+ Specific Icons (additional to the common icons)
Opens the Light Source Control dialogue which allows the attached light source to be set to
a given intensity. Please refer to the Manual Control of Light Source section for further
information.
Opens the Setup New PFD table dialogue. This function allows complex light regimes to be
configured for execution within an experiment. Please refer to the Configuration of PFD
Table section for further information.
Executes the currently defined PFD table. Please refer to the Configuration of PFD Table
table section for further information.
Display the existing photon flux density table

Display the quantum yield data.

Display both the quantum yield data and oxygen trace



51Oxygraph +

© 2019 Hansatech Instruments Ltd

1.6.2.3 Graph Area

Introduction to the Graph Area

The graph area of OxyTrace+ allows the signal from the electrode disc (and optional auxiliary
input) to be plotted on the PC screen as a real-time chart recorder emulation. Various controls and
functions exist to facilitate the way in which part or all of an experiment is displayed on screen.

The recorded signal is plotted to the graph at the predefined data acquisition rate. Once the
plotted traces reach to right side of the graph, the screen begins to scroll. The graph may be
scrolled in 3 different methods:
· Smooth Scrolling - the graph scrolls in the same fashion as a chart recorder.
· Half Screen - the graph shifts by half a screen.
· Full Screen - the graph shifts by a full screen.

These options may be selected from the Options menu.

During the measurement, OxyTrace+ can display up to 5 minutes worth of recorded data on screen
at any one time. Data recorded that is not in view may be easily reviewed by moving the horizontal
scroll bar at the bottom of the graph. This does not affect normal measurement.
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Axes Settings

OxyTrace+ features a comprehensive range of zoom controls in order that the recorded data may
be presented most efficiently on screen. They can be accessed either by selecting one of the
options in the Graph menu bar option or by clicking one of the following icons:

Zoom Window - Clicking this icon allows a selected portion of the trace to be enlarged.
Clicking this icon changes the mouse cursor to cross hairs. Clicking on the graph activates the
selection window. Drag the window to highlight the required section and click the mouse again to
zoom.

Auto Zoom - Clicking this icon automatically re-sizes the axes to efficiently present all
recorded data. This function may also be performed by pressing the F3 function key on the
keyboard.

Zoom XY - Clicking this icon opens the manual Set Axes window as shown below.

Axes are adjusted by entering in the required from and to values for oxygen, time and optional
auxiliary/fluorescence axes. If the auxiliary or fluorescence signals are disabled, the settings for
the associated axes are inaccessible. The grid lines that appear by default in the graph area can
also be modified in this dialogue.

Increase Zoom - Clicking this function zooms in on the centre section of the screen

Decrease Zoom - Clicking this function zooms out of the screen
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Undo Zoom - Click this icon to undo the previous zoom command. This function may also be
performed by pressing the F4 key on the keyboard.

Trace Settings

OxyTrace+ allows all individual signal traces to be assigned colours and data point symbols for
ease of identification. This is particularly important when using Oxygraph+ and Oxytherm+ multi-
channel systems at a full capacity of 8 individual channels with auxiliary channels enabled.

Clicking on the colour block adjacent to the channel numbers opens the standard Operating
System colour picker dialogue allowing a colour to be selected by assigning RGB values or by
selecting a predefined colour from the default Operating System colour palette. Clicking on the
symbol adjacent to the channel number opens a dialogue allowing the individual data point
marker to be selected from a set of 10 different options. The default selection is to hide these
data point markers. Unchecking the Hide Symbols check box at the bottom of the dialogue will
display all individual data point markers in the graph area.

The "Hide" check box column allows individual channel traces to be toggled in and out of view in
the graph area.

Colours and symbols of additional systems may also be defined, these settings are enabled once
OxyTrace+ detects multiple channels.
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1.6.2.4 Data Bar

The OxyTrace+  data bar presents a digital read out of the signals from the control unit. Data from
multi-channel systems will be displayed on individual lines. The information displayed is as
follows:

· Trace colours - Both oxygen and auxiliary trace colours are represented in the data bar so that
information can easily be matched to traces on screen in multi-channel systems.

· Oxygen electrode signal - Presented in nA when uncalibrated and nmols/ml (liquid-phase) or
µmol/RTA (gas-phase) when calibrated.

· Calibration indicator - Indicates whether the channel is:

= Calibrated

= Calibration has expired (see Calibration Details for information on Warning Intervals)

= Uncalibrated

· Rate Data - Displays the Live Rate according to the options selected (please refer to the Rate
section for further details)

· Output - Analogue output signal presented in mV
· Aux. Data - Displays the signal from an auxiliary input in arbitrary units if enabled (please see

Auxiliary Signals for further details)
· Set and actual chamber temperature - Oxytherm+ Only

Clicking the right mouse button on the data bar brings up an additional dialogue of options as
shown in the diagram above. This dialogue allows any of the columns (except for the oxygen
signal which is always visible) to be hidden or shown simply by clicking the appropriate column
heading. The default setting shows the live rate along with the oxygen signal, trace colour and
calibration status which are displayed as standard and are not selectable.
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PLEASE NOTE THAT THESE OPTIONS WILL BE DIFFERENT ACCORDING TO THE CONTROL UNIT IN
USE. THIS DIAGRAM SHOWS THE OPTIONS AVAILABLE FOR THE OXYTHERM+ CONTROL UNIT. IN

OXYGRAPH+ SYSTEMS, THE TEMPERATURE OPTIONS WILL BE HIDDEN. IN OXYLAB+ BASED
SYSTEMS, THE SET TEMPERATURE OPTION IS REMOVED AND FURTHER OPTIONS DISPLAYED ARE

LIGHT SETTING AND ACTUAL PAR READING IN ADDITION TO THE ACTUAL TEMPERATURE OPTION.
THESE SETTINGS REFLECT THE DIFFERENT OPTIONS AVAILABLE IN THE DATA BAR MENU.

The data bar may also be adjusted to show all enabled columns, just oxygen signal or no columns
by using the slide feature. By clicking and holding down on the slide you may drag the data bar to
the right to adjust between which columns will be shown.
Other features of the data bar are selectable font size (either small or large fonts) and a flashing
recording indicator in the bottom left corner of the data bar.
All of the controls for the Data Bar features may be accessed from the Data Bar menu.
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1.6.3 System Setup and Calibration

1.6.3.1 Instrument Summary

The Instrument Configuration window can be accessed either by selecting Hardware > Instrument
Summary from the menu bar, by clicking the  icon on the tool bar or by pressing the F8 function
key on the keyboard.

Channel selection
The buttons at the top of the window correspond to the possible 8 channels of a multi-channel
Oxygraph+ /Oxytherm+ system or possible 2 in Oxylab+ based systems. Channels which are
actively connected to the system are clickable whereas inactive channels are greyed out.

Oxygen Signal : Digital display of electrode signal
These meters show the readout from the electrode disc as a digital value. The calibrated units are
displayed in either nmol/ml for liquid-phase or µmol RTA for gas-phase calibrations, when
uncalibrated the units displayed are nA. 
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Signal: Legacy Units
Legacy Units are provided for the convenience of those familiar with using older instrments. They
are compatible with the un-calibrated units used on Oxygraph or Oxytherm. 

1.6.3.2 Data Aquisition Rate

OxyTrace+  is able to log data from the oxygen electrode and also from an optional auxiliary input
at several different user-defined acquisition intervals. The intervals available for selection
between each recording are:

100
msec

1 sec 10 sec

200
msec

2.5 sec

500
msec

5 sec

The acquisition rate settings are accessed by either selecting Hardware > Acquisition Rate from

the menu bar or by clicking the icon from the tool bar. The window above shows information
regarding the available data acquisition intervals. The table below shows further information for
data acquisition rates that is not given in the Acquisition rate window:
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The acquisition rate should be defined based upon the type of experiment to be performed. Assays
where rapid response in oxygen tension is to be studied should use the fastest acquisition rate
whereas experiments such as light response curves can afford a slower rate of data acquisition.

Once the acquisition rate has been selected, the OxyTrace+ software opens the Setup Live Rate
Display window

1.6.3.3 Sample Stirring

Sample Stirring

Electrochemical reactions taking place at the cathode of the electrode disc require the
consumption of oxygen in order to produce an electric current. This current is then digitised by an
electrode control unit and presented as a chart recorder emulation in the OxyTrace+  software.

The nature of this process means that as oxygen is continuously consumed at the cathode, an
oxygen depleted layer is produced immediately above the cathode. As the rate of consumption by
the disc is greater than the rate of oxygen diffusion through liquid, the measured signal from the
electrode disc will continuously decrease during measurement. This problem is overcome by
continuously stirring the sample in order to replenish the depleted layer at the cathode and to
ensure that the dissolved oxygen within the sample is kept evenly distributed throughout the
reaction vessel.

The magnetic stirrer is an integral feature of the electrode control unit and is located on the top of
the system. Stirring of the sample is achieved by placing a magnetic follower or "Flea" into the
reaction vessel itself. Activating the stirrer rotates the magnet beneath the stirrer cap at user
definable speeds of between 150 and 900 RPM. The flea tracks the magnetic stirrer, rotating just
above the cathode of the electrode so as not to cause any damage to the membrane preparation.
2 types of flea are available:

PTFE coated magnet
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This is the standard flea supplied with the systems. It consists of a small magnetic bar coated in
PTFE.

Glass flea
Glass fleas consist of several fine strands of iron sealed into a thin glass capillary tube.
Each type of flea has advantages and disadvantages of use. For example, for experiments where
very small changes in oxygen tension are to be measured, some users prefer the glass fleas as
PTFE is known to absorb a very minute amount of oxygen. In the large majority of applications
however, this absorption is not an issue. Glass fleas are not magnetic themselves so they are not
as reliable at tracking the rotating magnet in more viscous samples Therefore, the maximum
speed of stirring would be lower than that of the PTFE coated flea. The effects of the oxygen
depleted layer can be clearly seen by performing a short experiment:
Prepare the electrode disc and mount it into the base of the electrode chamber.

· Place the chamber on top of the magnetic stirrer.
· Add 2ml of air-saturated, de-ionised water into the chamber and drop a flea into the sample.
· Open the stirrer control window as described above and set the stirrer to a speed of 75%.
· Start a recording and allow the trace to stabilise.
· Once the trace has stabilised, stop the stirrer. The signal will start to decline steadily.
· Re-start the stirrer. The signal will return to it's original level.

The screenshot below shows how the trace should respond to the procedure outlined above.



60 Oxygraph +

© 2019 Hansatech Instruments Ltd

Operating the Magnetic Stirrer

The stirrer is controlled directly from the OxyTrace+  software. It can be accessed by selecting
Hardware > Stirrer Speed from the menu or by pressing the  icon on the toolbar. 

Single Unit 

If using a single unit system the following dialogue is generated.
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A stirrer speed is entered into the dialogue and can be adjusted with the up and down arrows. The
'Stirrer On' button will switch on the stirrer to the set speed. 

Multi Channel

If using a multi-channel system the following dialogue is generated:

The 'Enable' check boxes allow the required stirrers to be selected individually. Alternatively
'Enable All' or 'Disable all' can be used to quickly select which stirrers are used.

The 'Matched' functions allows all stirrers to be quickly set to the same value. Pressing this will
grey out the 'Speed' section for all other channels except for the first channel, this box is then
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used as the master speed. Any speed entered into this box will be updated for all available
channels.

Once the stirrer speeds have been configured, the 'On' or 'Off' buttons will toggle the stirrers on
and off. Stirrers can then also quickly be turned off/on bu pressing the  icon from the toolbar.

1.6.3.4 Programme Options

The Options dialogue is accessed by selecting Tools > Options from the software menu. The
following dialogue is displayed.

The functions of the options within this dialogue are explained below:
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1.6.3.5 Quantum Yield Measurements

Quantum Yield Graph Options

The Quantum Yield Graph Setup window is displayed automatically at the end of a light response
experiment. The image and points below describe the different areas of the Quantum Yield Graph
Setup window and explain the functionality of each element.

The diagram below shows the dialogue that is presented when the system is calibrated in liquid-
phase. There are several additional options that are displayed on the dialogue when the system is
calibrated in gas-phase.
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· A: Typical QY Graph

This diagram represents an ideal Quantum Yield graph and shows the roof and ceiling values.

The intercept on the vertical axis is a measure of dark respiration, that on the horizontal axis is the
light compensation point. The initial slope is a measure of quantum yield and its reciprocal,
quantum requirement. The curve lies within two constraints, a sloping "roof" and a "horizontal
ceiling" (the "true ceiling" or maximum rate).

The roof is a thermodynamic constant pitched at an angle dictated by the maximal photosynthetic
efficiency (in this instance a nominal quantum yield value of 0.111). The ceiling represents the
absolute maximum rate of carbon assimilation. For purposes of comparison, a lower or "nominal"
ceiling, imposed by the rate of carbon assimilation at 800 µmolsm-2s-1 is employed.
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· B: Displays the data acquisition rate that was used in the light response experiment. 
· C: The number of individual readings per light step that are used to calculate the rate of oxygen

change. 
· D: The default area of sample material taken into account when making the Quantum Yield

calculation. Any deviation in this figure will need to be accounted for and an area correction
should be made. 

· E: Quantum Yield graph axes settings. Can be set to auto scale or can be scaled manually. 
· F: The number of points on the graph that are taken into account when calculating the Roof or

Slope of the data. 
· G: The first point on the graph that is to be taken into account when calculating the Roof or

Slope of the data. 
· H: This option allows either the maximum rate measurement or the maximum level of

illumination recorded to be used as the Ceiling value of the data. 

1.6.4 System Calibration

Oxygraph+ 

The Oxygraph+ with DW1/AD chamber is a liquid phase system and therefore the liquid phase
calibration procedure should be followed however, with the purchase of additional equipment the
Oxygraph+ can be also used to measure gas phase samples.

For more details contact Hansatech Instruments Ltd.

1.6.4.1 Liquid Phase Calibration

Principles of Liquid-Phase Calibration

Before any measurements can take place, the electrode disc must be calibrated so that the
electrical signal received from the disc can be presented as actual calibrated units (nmol/ml).
Calibrating the disc for liquid-phase measurements involves a two step procedure in which the
signal from the oxygen electrode is referenced to 2 known oxygen concentrations in order to
derive an Offset and Calibration Factor.
The 2 calibration steps are:

Air Line

According to the studies of G.A. Truesdale and A.L. Downing (The solubility of oxygen in water,
1954, Nature 173: 1236), at any given temperature and atmospheric pressure, air saturated,
deionised water contains a known concentration of dissolved oxygen which may be calculated
mathematically. The following information is used by the OxyTrace+  software in order to

mailto:info@hansatech-instruments.com
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accurately reference the electrical signal from the electrode for the air line stage of calibration:
This data is based on measurements of dissolved oxygen in water at the given temperature and
standard atmospheric pressure published by Truesdale & Downing (Nature 173:1236, 1954).

The formula used in calculating the oxygen values in the table is as follows:

Cs=14.16 - (0.394 * T) + (0.007714 * T^2) - (0.0000646 * T^3)
{Where Cs is the oxygen saturated concentration in ppm and T is temperature in °C}

1 ppm is equivalent to 1µg/ml or (1µg/32g/mol) = 0.03125 µmol/ml
                                                                                            or
                                                                                    31.25 nmol/ml

At any atmospheric pressure other than standard atmospheric (760mm Hg or 101.32 KPa), the
value obtained is adjusted by a factor of:

Current atmospheric pressure
standard atmospheric pressure

The calibration factor is therefore calculated as is shown in the diagram below:
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In the example calibration above, the signal measured from the electrode in a stirred sample of
air-saturated, de-ionised water was 1600 nA. In the first step of the calibration, the user is
prompted to enter assay temperature and pressure variables. These entries are referenced against
the look-up tables and formula of Truesdale and Downing (see above) in order to establish the
amount of oxygen present within the chamber. This value, in this example, is 253.4 nmol/ml.
The measured 1600 nA must therefore, be married to the nmol/ml value in order to obtain the
calibration factor.

Zero Oxygen Line

In a perfect world, an oxygen concentration of zero would produce an electrical signal of zero from
the electrode disc. However, the electrode does have what is known as residual current which
does give a small signal in zero oxygen concentration.
It is necessary to subtract the value of signal caused by residual current from all recorded data
points in order to give accurate results. This is known as the Offset. Zero oxygen within the
reaction chamber can be achieved in 2 ways:

· Sodium Dithionite. - The addition of a strong oxygen reducing agent such as sodium dithionite
provides a good method of achieving zero oxygen. However, great care must be taken to remove
all traces of the dithionite before commencing measurement as even a minute amount of
remaining dithionite will have a serious effect on the oxygen concentration of the sample. Once
removed, the chamber should be thoroughly rinsed with distilled water several times.

IT IS CRUCIAL THAT CARE IS TAKEN, WHEN REMOVING THE SODIUM DITHIONITE AND WATER
FROM THE REACTION VESSEL, THAT THE MEMBRANE OF THE ELECTRODE IS NOT DAMAGED. THE

IDEAL METHOD OF REMOVING LIQUID FROM THE CHAMBER IS TO USE AN ASPIRATOR WITH A
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SOFT, RUBBER TIP (MIND THE FLEA!!!). IF AN ASPIRATOR IS NOT AVAILABLE, CAREFULLY USE A
PASTEUR PIPETTE TO REMOVE THE LIQUID.

· Nitrogen. - A more convenient method of achieving zero oxygen is to bubble nitrogen gas
through the liquid in the reaction vessel in order to displace all the oxygen. This method is in
some ways safer than the use of sodium dithionite as there is no risk of contaminating the
actual sample during the measurement and there is less risk of damaging the membrane of the
disc. However, the use of nitrogen is a slower process and to achieve zero line is more difficult
than dithionite.

Liquid Phase Calibration Process

Once the liquid-phase calibration routine has been selected, OxyTrace +  will generate a series of
prompts to guide you through the calibration process. Please follow the guidelines below to
complete the liquid-phase calibration process.

Air Line

Prepare the disc as described in the Electrode Preparation section, install into the base of the
electrode chamber and connect the electrode disc to the rear of the control unit using the
electrode connection cable. Place 2ml of air saturated, deionised water into the reaction vessel.
Air saturated water is obtained by vigorously shaking a small quantity of deionised water (approx.
50ml) in a large conical flask (approx. 1L). In all systems (with the exception of the Oxytherm
electrode control unit), connect the water jacket of the electrode chamber to the circulating water
bath for temperature control purposes and ensure that the sample and electrode disc equilibrate
to the temperature required by the assay before commencing calibration. Oxytherm users should
set the chamber temperature directly from the OxyTrace +  software temperature settings.

IT IS IMPORTANT TO REMEMBER THAT THE SAMPLE OF AIR SATURATED WATER SHOULD BE
EQUILIBRATED TO THE ASSAY TEMPERATURE BEFORE THE CALIBRATION PROCEDURE BEGINS. IT
CAN BE PRE-EQUILIBRATED IN A WATER BATH OR SIMPLY ALLOWED SUFFICIENT TIME TO REACH

TEMPERATURE ONCE ADDED TO THE REACTION VESSEL.

The liquid-phase calibration sequence is activated either from the Calibrate > Liquid-Phase

Calibration menu option or directly from the  icon on the toolbar. Once activated, the following
window is generated.
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Entering the appropriate temperature and atmospheric pressure into this window allows the
OxyTrace +  software to accurately reference the air line. Whatever signal is recorded from the
electrode disc during the air line phase will be subjected to the formula of Truesdale and Downing
(see Principles of Liquid-Phase Calibration page) in order to derive the calibration factor. Once the
correct variables have been entered into this window, proceed by pressing OK.
The following window is generated.

Assay temperature and ambient pressure variable defined in the previous window are displayed as
confirmation. The stirrer setting should provide efficient, smooth stirring of the sample without
causing a noisy signal. Please refer to the Stirrers section for details on selecting an appropriate
stirring rate. Once the stirrer setting has been selected, proceed by pressing OK. The following
window is generated.
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Observe the mV signal in the window above and wait until the prompt that a plateau has been
reached. Once the signal is deemed to be stable, the OK button should be pressed in order to
proceed.

IN THE CASE OF A NEW OR WELL MAINTAINED ELECTRODE DISC, YOU WOULD IDEALLY EXPECT
TO SEE A SIGNAL OF APPROX. 1600NA (± 240NA) WHEN MEASURING AIR LINE IN AIR SATURATED
WATER. THE ACTUAL SIGNAL LEVEL AT THIS POINT IS NOT CRITICAL; IT IS MORE IMPORTANT
THAT THE SIGNAL IS STABLE WITH MINIMAL NOISE. HOWEVER, IF THE SIGNAL LEVEL IS LOWER
THAN 1300NA, IT COULD INDICATE A PROBLEM WITH THE ELECTRODE ITSELF.

If the signal from the electrode disc does not become stable after several minutes, this could be
indicative of either one or a combination of several problems. For details on how to isolate the
fault to either the electrode disc, the control unit or the electrode connection cable, please refer to
the Electrode Disc Diagnostics section for further information.

Zero Oxygen Line

The second stage of the calibration procedure is to establish the zero oxygen line in order to
determine the Offset (see see Principles of Liquid-Phase Calibration page). To perform this stage,
use either of the following methods:

· Nitrogen gas - bubble nitrogen gas into the reaction vessel in order to displace all the oxygen in
the sample.

· Sodium Dithionite - a few crystals of this strong reducing agent is sufficient to reduce all the
oxygen dissolved in the sample.

·
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IN THE CASE OF A NEW OR WELL MAINTAINED ELECTRODE DISC, YOU WOULD NORMALLY
EXPECT TO SEE A SIGNAL OF LESS THAN 1% OF THE SIGNAL OBSERVED DURING THE AIR LINE
STAGE. FOR EXAMPLE, IF THE AIR LINE SIGNAL WAS 1506 NA, YOU WOULD EXPECT THE ZERO

LINE TO MEASURE LESS THAN 15.06 NA.

If the zero oxygen line recorded from the disc seems to be too high, this could be indicative of one
of several things:

· Insufficient oxygen reduction/removal from sample - sodium dithionite does have a finite shelf-
life. If old dithionite is used, there is a possibility that the oxygen reducing capabilities will be
significantly reduced or absent altogether. Always ensure that sodium dithionite is kept in small
quantities in a clearly labelled air-tight container. Bubbling nitrogen into the chamber must be
performed carefully in order to ensure that all oxygen has been displaced.

· Damaged electrode disc - unfortunately, most cases of high residual current reported are due to
insufficient electrode maintenance. If the electrode is left to dry out after measurements have
been completed, KCl crystallisation can irreversibly damage the disc by penetrating any minute
fissures in the seal between the platinum cathode and the epoxy electrode dome and forcing the
seal apart. This problem has a "snowball" effect as every time the disc is prepared from now on,
KCl will enter the fissures causing them to widen. Please refer to the Electrode Maintenance
section for further information.
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· Once the zero oxygen stage has been completed, press OK to proceed. The following window is
generated.

Details of the completed electrode calibration factor are presented in this window. Click Save
Calibration to store the information or click Exit without saving to discard this calibration factor. If
the calibration has been unsuccessful, OxyTrace +  will display a warning message and an
indication of which parameters have not been successful.

Manual Calibration Process

Systems are used for measurement of samples in a wide range of different mediums and in some
cases, it is desirable to calibrate the system using the medium in question in place of the air-
saturated distilled water used in the standard, documented calibration routine.

O2view has a built calibration routine that allows a known concentration of oxygen to be assigned
to a signal from the electrode disc.
If an alternative medium is to be used, it is important to remember that the solubility of oxygen in
the medium will more than likely be different to that of distilled water.
The following example shows a manual calibration routine using seawater in place of air-
saturated distilled water.

The oxygen content will depend upon both the salinity and temperature of the water. The oxygen
content of sea water over a range of salinity and temperature has previously been determined by
Green and Carritt (1967) and is presented in the table below.
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ALTHOUGH THIS CALIBRATION ROUTINE HAS BEEN REFERRED TO AS SEAWATER CALIBRATION, IT
IS POSSIBLE TO USE THIS ROUTINE TO CALIBRATE THE SYSTEM USING ANY OTHER MEDIUM

PROVIDED THE OXYGEN CONCENTRATION OF THE MEDIUM IS KNOWN

Performing the Manual Calibration

Prepare the electrode disc and mount it in the electrode chamber. Ensure the disc is responding
correctly before adding the seawater that is to be used for the calibration routine to the electrode
chamber ensuring that the seawater is at the correct temperature for the experiment. Allow the
electrode disc signal to stabilise. From the Menu bar, select Calibrate > Liquid Phase Calibration >
Manual . The following dialogue opens.
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Enter the known oxygen concentration into the Oxygen concentration input. This value will be
referenced to the initial, stable oxygen electrode signal level in place of the standard airline
measurement. Then select the choice of units you wish to use by either selecting one of the given
units or by using 'Other' and entering any units you desire.

Once this step of the calibration routine is complete, the calibration routine is identical to the
standard liquid-phase calibration routine. Please refer to the Liquid-Phase Calibration section for
further information.

Viewing Calibration Details

Once the system has been successfully calibrated in either liquid or gas-phase, details of the
calibration may be viewed in a separate window. This window is accessed from the Calibrate >
Oxygen Calibration Details option from the menu bar.
All aspects of the calibration are shown in the window as shown in the diagram below:

The Date column is relevant should the apparatus be intended for long measurement assays
lasting more than a day or if the electrode is to be left prepared and in situ (please note that this
should only be performed in liquid-phase electrode chambers as electrodes in gas-phase "dry
out"). A calibration warning interval may be set so that after a given number of days post
calibration, the user is prompted that the calibration has expired when the software is initially run.
Please refer to the Set Oxygen Calibration Warning section for further information.
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Set Calibration Warning

If the apparatus is intended for long measurement assays lasting more than a day or if the
electrode is to be left prepared and in situ (please note that this should only be performed in
liquid-phase electrode chambers as electrodes in gas-phase "dry out"), a calibration warning
interval may be set so that after a given number of days post calibration, the user is prompted that
the calibration has expired when the software is initially run. A calibration warning can also be set
in the same manner for any auxiliary devices connected to the instrument.

IT IS IMPORTANT TO REMEMBER THAT OVER TIME, A POLARISED DISC BUILDS UP A DEPOSIT OF
BLACK SILVER OXIDE DUE TO THE NATURE OF THE ELECTROCHEMICAL REACTIONS TAKING

PLACE. A DISC THAT IS LEFT MEASURING FOR MORE THAN A DAY MAY BEHAVE DIFFERENTLY AT
THE END OF THE ASSAY THAN AT THE BEGINNING. PLEASE REFER TO THE SECTION LEAVING THE

ELECTRODE DISC POLARISED OVERNIGHT.

1.6.4.2 Gas Phase Calibration

Principles of Gas-Phase Calibration

Before any measurements can take place, the electrode disc must be calibrated so that the
electrical signal received from the disc can be presented as actual calibrated units (µmol Relative
To Air). Calibrating the disc for gas-phase measurements involves a three step procedure in which
the signal from the oxygen electrode is referenced to known oxygen concentrations in order to
derive an Offset and Calibration Factor. The following steps are used in order to calibrate the
electrode:
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Air Line

The air-line refers to the signal recorded by the electrode disc in ambient air. It is this value that is
used as the calibration offset.

Injection / Removal Line

In order to obtain a calibration factor, the software requires the addition of a known oxygen
concentration to reference against a level of change in the bit signal from the disc. This is
performed by adding or removing 1ml of air from the electrode chamber using a syringe. Either
addition or removal of air results in the same calibration factor. The user is given both options
depending on the type of assay performed. For example, oxygen evolution measurements should
use an injection of 1ml, oxygen consumption measurements should use a removal of 1ml of air as
good laboratory practice.

At given temperature and pressure, gas laws dictate that the amount of oxygen present in 1ml of
air can be easily calculated. At standard temperature (273.15 degrees Kelvin or 0 °C) and pressure
(101.32 kPa or 1 atmosphere), the amount of oxygen in 1ml of air (containing 21% by volume) is
210µl. Since 1 mole of gas occupies 22.414µl, this is equivalent to:

210
22.414

OR

9.37Ì MOLES

At any other temperature, the amount can be derived by multiplying by a factor of:

273
(273+T°C)

(where T is the experimental temperature) so that, for example, at 25°C :

273
                     (273+25°C)      = 0.9161

9.37 Ì MOL X 0.9161 = 8.58

THEREFORE, 1ML OF AIR AT 25°C CONTAINS 8.58 Ì MOL OF OXYGEN.

At any other pressure the amount derived above should be adjusted by a factor of:
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CURRENT ATMOSPHERIC PRESSURE
101.32 KPA (STANDARD ATMOSPHERIC PRESSURE)

This factor is then married with the change in bit level during the injection / removal of air in order
to obtain a calibration factor. The following diagram shows how this factor is obtained.

Gas Phase Calibration Process

Please follow the guidelines below for the gas-phase calibration sequence:

· Prepare the disc as described in the Electrode Preparation and Maintenance manual (supplied
with the S1 electrode) and install into the base of the electrode chamber.

· Connect the electrode disc to the rear of the control unit using the electrode connection cable.
· Ensure that the appropriate sample mounts and gas-taps are fitted to the electrode chamber

(refer to either of the Gas-Phase Chambers manuals).
· Connect the water jacket of the electrode chamber to the circulating water bath for temperature

control purposes and ensure that the leaf chamber and electrode disc equilibrate to the
temperature required by the assay before commencing calibration.

Step 1

The gas-phase calibration sequence is initiated by selecting Calibrate > Gas Phase Calibration
Once selected, the following window is generated.
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Select method for calibration to either inject 1ml of air or remove 1ml of air. Then enter the
relevant temperature and air pressure variables into this dialogue and press OK. 

Step 2

Ensure that the gas taps are in the open position and press OK to continue

Step 3
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Here both the oxygen signal and rate of change are displayed.  The software will wait until a
plateau has been reached before moving onto the next step  "Please wait for the signal to plateau
" is displayed at this time as well as an override button which allow you to bypass this wait time if
you are happy with the signal level (BEWARE THIS MAY AFFECT THE ACCURACY OF THE
CALIBRATION IF THE SIGNAL IS NOT FULLY STABILISED). The value that has been recorded for the
air line will be used as the Calibration Offset.

During measurement, the signal recorded from the disc in ambient air will be displayed as the
origin of the axes (0). Any oxygen evolution / consumption by a sample will be displayed in the
calibrated unit µmol relative to the air line.

IN THE CASE OF A NEW OR WELL MAINTAINED ELECTRODE DISC, YOU WOULD NORMALLY
EXPECT TO SEE A SIGNAL OF APPROX. 2050MV (HALF THE RANGE OF THE CONTROL UNIT

RESOLUTION) WHEN MEASURING AIR LINE IN A GAS-PHASE ELECTRODE CHAMBER.

If the signal from the electrode disc does not become stable after several minutes, this could be
indicative of either one or a combination of several problems. For details on how to isolate the
fault to either the electrode disc, chamber, the control unit or the electrode connection cable,
please refer to the System Diagnostics section.

Once the signal has stabilized OK will be displayed

Step 4
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This stage of the calibration procedure is to establish the Injection / Removal line in order to
determine the Calibration Factor. By injecting / removing 1ml or air to / from the electrode
chamber, the bit signal recorded by the disc will change. The final amount of bits excursion in
signal will then be referenced to a calibrated unit (µmol) taking into account any temperature and
pressure variables entered in step 1. Please refer to the previous section for a full description of
the mathematics involved in this calibration step.

Before selecting OK at this dialogue, use a syringe fitted securely into the gas port and either
remove or add 1ml of air into the chamber (depending on the option selected in step 1). LD2/3
electrode chamber users should ensure that the
second gas port is closed. 

Quickly close the gas port once the air has been injected/removed and press OK.

Step 5

At this point an increase/decrease of oxygen signal should be observed depending on option to
inject/remove air.

IN THE CASE OF A NEW OR WELL MAINTAINED ELECTRODE DISC, YOU WOULD NORMALLY
EXPECT TO SEE A SIGNAL CHANGE OF APPROX. 9% OF THE MEASURED AIR LINE AFTER A 1 ML

INJECTION / REMOVAL.
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Allow the signal to stabilise at the new level just as with step 3. Once the oxygen signal has
reached a plateua OK will be displayed.

If the signal does not stabilise and begins to drift downwards/upwards, this is indicative of a leak
in the chamber. Please refer to the System Diagnostics section for details on isolating and fixing
leaks in gas-phase electrode chambers.

Step 6

In this step of the calibration, the air-line is re-checked by opening the gas taps and measuring the
signal from ambient air in exactly the same way as in calibration step 3. Press OK to continue

Step 7
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Follow the same procedure as step 3.

Step 8

Once the calibration is complete, details of the factor and offset applied during the calibration will
be displayed. The calibrated units and temperature are also displayed. 

The Save Calibration option will update the instrument with the calibration factor and offset ready
for measurements to be taken.

The exit without saving option will disregard this calibration and will revert the instrument to its
previous state, either uncalibrated or using a previously saved calibration. 
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Viewing Calibration Details

Once the system has been successfully calibrated in either liquid or gas-phase, details of the
calibration may be viewed in a separate window. This window is accessed from the Calibrate >
Oxygen Calibration Details option from the menu bar.
All aspects of the calibration are shown in the window as shown in the diagram below:

The Date column is relevant should the apparatus be intended for long measurement assays
lasting more than a day or if the electrode is to be left prepared and in situ (please note that this
should only be performed in liquid-phase electrode chambers as electrodes in gas-phase "dry
out"). A calibration warning interval may be set so that after a given number of days post
calibration, the user is prompted that the calibration has expired when the software is initially run.
Please refer to the Set Oxygen Calibration Warning section for further information.

Set Calibration Warning

If the apparatus is intended for long measurement assays lasting more than a day or if the
electrode is to be left prepared and in situ (please note that this should only be performed in
liquid-phase electrode chambers as electrodes in gas-phase "dry out"), a calibration warning
interval may be set so that after a given number of days post calibration, the user is prompted that
the calibration has expired when the software is initially run. A calibration warning can also be set
in the same manner for any auxiliary devices connected to the instrument.
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IT IS IMPORTANT TO REMEMBER THAT OVER TIME, A POLARISED DISC BUILDS UP A DEPOSIT OF
BLACK SILVER OXIDE DUE TO THE NATURE OF THE ELECTROCHEMICAL REACTIONS TAKING

PLACE. A DISC THAT IS LEFT MEASURING FOR MORE THAN A DAY MAY BEHAVE DIFFERENTLY AT
THE END OF THE ASSAY THAN AT THE BEGINNING. PLEASE REFER TO THE SECTION LEAVING THE

ELECTRODE DISC POLARISED OVERNIGHT.

1.6.5 Data Handling

1.6.5.1 Event Marking

Adding Event Marks

During an experiment, certain events may occur that require documentation. For example, in a
study of mitochondrial response to the addition of ADP would require a marker to indicate at what
point the ADP was added so that the speed at which the mitochondria responded to the addition
can be assessed.
OxyTrace+  makes provisions for this by allowing the addition of event marks with user-defined
labels and comments. At any point during the measurement, an event mark can be added either by

selecting Tools > Add Event Mark from the menu bar, by clicking the icon on the tool bar or by
pressing the F5 function key on the keyboard. The following window is generated:
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Any text typed into the label or comment fields of the Add Event Marker window may be saved to
the OxyTrace+  configuration file on exiting. The following dialogues are generated allowing the
text to be saved or not:

Saved labels and comments will then be available by selecting from the drop down boxes.

PLEASE NOTE THAT IF THE CONFIGURATION FILE IS DELETED FOR ANY REASON, THE LABELS AND
COMMENTS THAT HAVE BEEN PREVIOUSLY DEFINED WILL BE LOST.
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Event markers are displayed at the top of the graph area along with any label that has been
assigned. Any comment that has been added to the event mark is displayed when the mouse
cursor is hovered over the event mark on the graph as shown in the diagram above. This feature
may also be disabled from the Options menu. Event markers may be reviewed and edited or
deleted at any point during and after the measurement. Events are also saved with the experiment
and are printed.

For some functions of the software, event markers are automatically added to the graph and
cannot be edited or deleted. These features include:

· Start recording - indicated by a right-facing arrow and the label "Start"
· Stop recording - indicated by a left-facing arrow and the label "Stop"
· Stirrer speed adjustment - indicated by 2 downwards arrows with the label "Stirrers". The first

mark is added when the stirrer window is first opened, the second when the stirrer window is
closed. This indicates that between these 2 points, stirrer settings were being adjusted

· Light on - indicated by a light symbol and the label Light on
· Light intensity change - indicated by a light symbol with either an up or down pointing arrow to

indicate an increase or decrease in intensity.

Editing Event Marks

Event marks can be reviewed and edited or deleted at any point during and after the experiment.
Selecting Tools > Edit Event Marks from the menu bar opens the following window.

The event to be edited is displayed in a blue box along with the information associated with it. If
any changes are made, the Save button should be pressed before either exiting the window or
moving to another mark using the previous or next buttons. Please note that only the text
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associated with the event mark may be changed. The type of event (up or down) cannot be
amended.

Deleting Event Marks

To delete an event mark, select Tools > Delete Event Marks from the menu bar. The following
window is displayed:

The event to be edited is displayed in a red box along with the information associated with it.
Select the relevant event mark using the previous and next buttons and press delete to remove the
event mark from the graph.

1.6.5.2 File Information

Experiments recorded in the OxyTrace+  software can be saved along with an information set
giving details of the following:

· File name and path
· Date of experiment
· Start time of experiment
· Data acquisition rate used in the experiment
· OxyTrace+  version information
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· Details of what traces were recorded (i.e. number of channels, auxiliary data
· A text description of the experiment

File information is viewed from the following window:

This window is accessed either by selecting View > File Information from the menu bar or by

clicking the  icon on the tool bar. A text description is added by typing the relevant comments
into the Comments text box. The File Information dialogue is also initially displayed when opening
previously saved measurement data.

1.6.5.3 Rate Measurements

Live Rate

Setup Live Rate Display

During measurement, the oxygen signal is continuously monitored by OxyTrace+  software for the
rate of change in oxygen tension. A Live Rate measurement is displayed in the Data Bar giving an
indication of the rate at which oxygen is evolving or being consumed by the sample.
The Live Rate is calculated by performing a least squares regression over a user-defined duration
of measurement. The duration is defined in the Setup Live Rate Display window which is accessed
by selecting Rate > Setup Live Rate Display from the menu bar.
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The rate is continuously re-calculated over the time period defined and displayed in the data bar
in nmol/min for liquid-phase and µmol RTA/min for gas-phase measurements. The longer the time
duration selected, the more stable the rate measurement will be. In addition, Live Rate data may
also be plotted to the OxyTrace+  axes for graphical representation. Please refer to the Plotting
Live Rate Data section for further information.

Plotting Live Rate Data

By selecting Tools > Graph Data plus Rate Data or the  icon from the tool bar, both oxygen
signal data and associated Live Rate data are plotted on a horizontally split screen with oxygen in
the lower section and Live Rate data in the upper section as shown in the diagram below.
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In this data display mode, additional axes scaling options are included in the Zoom XY axes
settings dialogue allowing the Live Rate axes to be scaled as required.

Manual Rate Measurements

OxyTrace+  allows rate of change of oxygen tension to be measured on recorded data from the
electrode disc using the Rate Measurement Function.

Rate measurements are made by either "clicking and dragging" a pair of Rate cursors to the
required positions or by manually entering start and end times on the recorded oxygen signal in
order to define the rate interval. The 2 cursors appears as vertical lines on the graph screen. The
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left rate cursor is used to move the rate interval along the trace whereas the right rate cursor is
used to set the rate interval itself.

The rate cursors may be activated either by selecting Rate > Rate Cursors from the menu bar or by

clicking the  icon on the tool bar. The 2 vertical cursors will be displayed on the screen along
with the Rate Table. To manually set the rate interval, select Rate > Enter Rate Cursor Times from
the menu bar. A window is generated allowing start and end times to be set as shown in the
diagram below.
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In a multi-channel system, rates may be measured either on all traces simultaneously or on
individual channel traces. Once the rate cursors have been activated, select Rate > Select
Channels from the menu bar. A window is displayed allowing either all traces or individual
channels to be included in the rate measurement.

This option may also be selected from the Rate Table itself.

When the rate interval cursors are moved along the trace, OxyTrace+  software automatically
draws a line of best fit between the 2 cursors. The line of best fit is calculated by least squares
regression and can be displayed or hidden from the Rate > Setup Line of Best Fit option in the
menu bar.
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Line of Best Fit can be configured to calculate along individual channels or to be toggled between
on and off (show/hide).

Once the desired rate interval and position has been defined, the rate can then be entered into
the rate table by either selecting Rate > Add Rate to Table from the menu bar. Confirmation of the
rate will be displayed before addition to the main rate table as shown in the image below:

Once the information displayed in the window above has been checked, it may be added to the
main rate table simply by clicking the Add button.
Once added to the main rate table, rate data can be normalised if required. The normalise window
allows a factor to be entered and also if the normalisation factor is to be multiplied or divided by.

In addition, the horizontal and vertical intersecting lines used to calculate the rate measurement
are displayed on the graph once the rate has been added to the table. These graphics appear with
labels which may be defined to represent the rate measurement number or the rate value. The
labels can be configured to show rate measurement reference numbers to correspond with the
measurements shown in the rate table or the actual rate value itself. The rate measurement labels
are indicated on the trace by a series of horizontal and vertical lines above or below the trace
showing how the slope has been calculated. These lines may be shown as coloured (to match the
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trace colour) or black. These options are accessed by selecting Tools > Options from the software
menu bar.

The rates are displayed on the graph screen as shown in the diagram below:

Any measured rates are saved along with the file and are also included in the print out.

1.6.5.4 Tabulated Data

Once the experiment is complete, data can be viewed optionally in numerical format as the
individual recorded data points. This data is shown either by selecting Tools > Tabulate Data from

the menu bar or by clicking the  icon from the tool bar. The data from all signals and channels
is displayed as shown in the image below:
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If the print function is selected whilst the tabulated data screen is displayed, the data will be
printed in tabulated form.

1.6.5.5 Exporting Data to Other Software Packages

Data recorded in OxyTrace+ is saved as a *.CSV (Comma Separated Values) file. This file type may
be opened and reviewed directly in Microsoft Excel so that data may be subjected to further, more
advanced statistical analysis.

ALL DATA SAVED IN OXYTRACE+ SOFTWARE IS SPECIFICALLY ENCRYPTED. IF ANY AMENDMENTS
ARE MADE TO DATA FILES OUTSIDE OF OXYTRACE+ SOFTWARE, NOTIFICATION OF EXTERNAL

CHANGES IS DISPLAYED WHEN THE FILE IS RELOADED INTO THE SOFTWARE. THIS NOTIFICATION
IS ALSO DISPLAYED ON PRINTED EXPERIMENTS.

1.6.5.6 Printing Data

OxyTrace+  allows a comprehensive print out of completed experiments. Information including
data acquisition rates, gain and back off settings and calibration information are included in the
print out along with a printed graph, event marker and rate measurement details. If the data has
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been modified outside of the OxyTrace+  software, a warning message will be printed at the top of
each page as notification. 

Alternatively, if only a single page printout showing the graph only may be printed by selecting the
Simple Print option in the Options menu

If tabulated, numeric data is required, change the view to the tabulated data screen and select

File > Print from the menu bar or click the  icon on the tool bar.

1.6.5.7 Viewing Previously Saved Data

Previously saved files may be viewed at any time using the File > Open command from the menu

bar or the  icon from the toolbar. Alternatively, OxyTrace+  can be run in View Mode which
allows the software to function as a stand alone operation when a control unit is not detected
however, some operational functions will be disabled.

To operate OxyTrace+  in view mode when a control unit is not present, simply run the software as
normal. The software initially scans for connected control units and when none are found, the
following window is displayed.
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Pressing OK opens OxyTrace+  allowing data files from Oxylab+ , Oxygraph+ or Oxytherm+ control
units (to be loaded and analysed using the integral data analysis functions. Obsolete commands
and functions are disabled during view mode. These functions include:

· Recording controls
· Stirrer controls
· Gain / Back off settings
Normal function of the software may be re-established by reconnecting a powered control unit to

the PC via USB cable and pressing the  icon from the toolbar or by selecting Hardware > Scan
for Instruments from the menu bar. This function looks for control units currently connected to the
PC. Once found, the serial number, type and calibration status are displayed.

1.6.6 Recording an Auxiliary Signal

1.6.6.1 Connecting the Auxiliary Device

Oxygraph+, Oxytherm+ and Oxylab+ control units are able to record the signal from an optional
auxiliary input. This signal could be from a range of different devices provided the device output is
analogue between 0 - 4V. Example devices are:

· Thermometer
· pH electrode
· TPP+ electrode (or other ion selective electrode)
· Output from fluorimeter
· PAR

1.6.6.2 Enabling the Auxiliary Device

OxyTrace+ software is configured to accept an auxiliary input device from a window accessed by
selecting Calibrate > Calibrate Auxiliary/pH/Other ISE from the menu bar. The following dialogue
is generated.
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Auxiliary inputs for each active channel are enabled by checking the appropriate check box in the
window shown in the diagram above. An auxiliary axis is added on the right side of the graph
screen and the signal itself is plotted in the graph area as a real time chart recorder emulation.
The signal is displayed in numerical format in the Data Bar (if enabled) along with the
corresponding trace colour. All individual data points can be reviewed in tabulated format once
the measurement has completed.

1.6.6.3 Calibrating the Auxilary Device

Auxiliary Channel Calibration

OxyTrace+  provides a 2-point calibration routine for any connected auxiliary device allowing the
auxiliary signal to be recorded in actual calibrated units. The calibration routine takes mV readings
at a lower and upper calibration points and calculates a calibration factor and offset accordingly.

To calibrate the auxiliary device, select Calibrate > Calibrate Auxiliary/pH ISE/other ISE from the
menu bar.
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This displays all channels and any auxiliary devices that may be connected, from here you can
enable which auxiliary device you want to use. Please refer to Auxiliary calibration, pH calibration
and ISE calibration for more details on the calibration routines.

Auxiliary Device Calibration

Once the auxiliary channel has been enabled clicking the calibrate button will start the calibration
routine.
The first stage of calibration is to enter the units required. This will be dependent on the type of
auxiliary device you are using but in the example below, a temperature probe has been used
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Once the required calibrated units have been entered, click OK to continue.

The next step is to assign the low calibration point. In this example, the temperature probe was
situated in the chamber reaction vessel with a water bath connected to the chamber at a constant
20°C. This value should be entered into the "Equates to" spin box. Once the actual signal level has
stabilized, click OK to continue.

The next step is to assign the upper calibration point. In this example,he temperature probe was
situated in the chamber reaction vessel with a water bath connected to the chamber at a constant
40°C. As with the previous step, enter the calibration standard value into the "Equates to" spin box
and once the actual signal level stabilizes, click OK to continue.

OxyTrace+  calculates the calibration factor and offset according to the values entered and
associated auxiliary device signal levels. The calibration details are displayed in a Results
dialogue at the end of the process which may be saved or discarded.
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In multi-channel systems, if more than 1 auxiliary channel has been enabled, OxyTrace+  will
proceed to the beginning of the auxiliary calibration routine to allow calibration of the next
auxiliary channel in the system once the Save button is clicked.

pH Device Calibration

Once the pH channel has been enabled clicking the calibrate button will start the calibration
routine. The first stage of calibration is to place the pH electrode into the first known pH solution.
You will be prompted to do this before the software analyses the data from the electrode. Ideally
the pH of this solution should be around the same as the lowest value you expect to measure.

Once the electrode has been placed into the first solution and the software has analysed the
signal from it, enter the pH and the temperature of the solution into the dialogue boxes.
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The software will wait for the signal to stabilise before making the "Next Solution" button
available. However, you will be able to press the "Accept" button to the left of the "Approximate
Drift" field if you consider the level of drift to be acceptable. This will affect the accuracy of your
calibration.

After pressing "Next Solution" you will be asked if your next solution is available and then to to
place the probe into that solution.

This should be of a pH in between your highest and lowest pH you expect to measure.
The software will analyse the signal again in the exact same manner as solution 1. Again, make
sure the "Calibration Solution pH" field reflects the pH of the solution you are now using
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After pressing "Next Solution" you will be asked if your next solution is available and then to to
place the probe into that solution.

This should have a pH around the same as the highest value you expect to measure.
The software will analyse the signal again in the same manner as solution 1 and 2. Again, make
sure the "Calibration Solution pH" field reflects the pH of the solution you are now using

Press "Finish"
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Once the calibration routine has finished the details will be saved and shown in the final dialogue
box. They can also be found in the auxiliary calibration details window in the calibrate menu.

Ion Selective Electrode (ISE) Calibration

Once the ISE channel has been enabled clicking the calibrate button will start the calibration
routine.

Before clicking the calibrate button make sure the ISE is in your first calibration solution as the
software will analyse the signal from the ISE straight away.

On the first dialogue window you will be able to enter a title for the calibration, most commonly
used is the type of ISE in use.

Once the signal has been analysed from the ISE, enter the known concentration of the solution
into the calibration solution box. After this has been done press next and then place the ISE into
the final calibration solution
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The software will analyse the signal from the ISE again, once the output has stabilised and the
drift is stable enter the concentration of the calibration solution. Press the finish button to finalise
the calibration.

Once the calibration routine has finished the details will be saved and shown in the final dialogue
box. They can also be found in the auxiliary calibration details window found in the calibrate
menu.
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Auxiliary Device Calibration Details

To review calibration details for connected auxiliary devices, select Calibrate > Aux Calibration
Details from the menu bar. Calibration details for each channel are displayed in the dialogue as
shown below.

Set Calibration Warning

If the apparatus is intended for long measurement assays lasting more than a day or if the
electrode is to be left prepared and in situ (please note that this should only be performed in
liquid-phase electrode chambers as electrodes in gas-phase "dry out"), a calibration warning
interval may be set so that after a given number of days post calibration, the user is prompted that
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the calibration has expired when the software is initially run. A calibration warning can also be set
in the same manner for any auxiliary devices connected to the instrument.

IT IS IMPORTANT TO REMEMBER THAT OVER TIME, A POLARISED DISC BUILDS UP A DEPOSIT OF
BLACK SILVER OXIDE DUE TO THE NATURE OF THE ELECTROCHEMICAL REACTIONS TAKING

PLACE. A DISC THAT IS LEFT MEASURING FOR MORE THAN A DAY MAY BEHAVE DIFFERENTLY AT
THE END OF THE ASSAY THAN AT THE BEGINNING. PLEASE REFER TO THE SECTION LEAVING THE

ELECTRODE DISC POLARISED OVERNIGHT.

1.6.7 Multi Channel Systems

1.6.7.1 Introduction to Multi-channel Systems

Both Oxygraph+ and Oxytherm+ control units are capable of operating either as stand alone
systems or in complex multi-channel systems consisting of up to 8 control units. These control
units may consist of a mixture of both types of unit linked via USB and operated by a single PC.

Oxylab+ control units may also be linked together but only up to a maximum of 2 channels.
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Each of the control units in the multi-channel system must be calibrated independently to allow
for differences in electrode performance. 

WHEN RUNNING A MULTI-CHANNEL SYSTEM, ALL UNITS MUST BE CALIBRATED. OXYTRACE+ 
SOFTWARE WILL NOT ALLOW A RECORDING FROM A SYSTEM WITH A MIX OF CALIBRATED AND

UNCALIBRATED CONTROL UNITS PRESENT.

1.6.7.2 Setting Up a Multi Channel System

What Additional Hardware is Required?

It is perfectly possible to link 2 or more (depending on system type) control units together in a
multi-channel setup without purchasing any additional hardware. However, there are options
available which will cut the cost of multi-channel systems.

Oxylab+ based systems such as Chlorolab2+, Chlorolab 3+ and Leaflab 2+ may only be extended
by one control unit to a dual channel system. Oxygraph+ and Oxytherm+ systems may be extended
up to a maximum of 8 channels.

Oxygraph+ control units draw very little power. Consequently, it is possible to run up to 8
individual control units from a single power supply with the aid of the OXY/PDU Power Distribution
Unit.

In addition, it would not be necessary to purchase a full set of spares and accessories with every
control unit. Hansatech Instruments recommend the purchase of 1 spares and accessories kit for
every 4 control units.

The most cost effective method of purchasing, for example, a system comprising 4 control units
would include the following items:

· 1 x Oxygraph+ System complete
Consists of control unit, DW1/AD electrode chamber, S1 electrode disc, S1/SMB connection cable,
USB Serial Cable, A2 membrane applicator, A3 top plate key and alignment jig, S2/P magnetic
followers, S3 spare reaction vessels, S4 reel of membrane, S7A spare O-rings, S16 electrode
cleaning kit, 12V power supply, mains cable and OxyTrace+  software.
· 3 x Additional channel Oxygraph+ control units
Including 3 x Oygraph+ control units, 3 x 12V power cable, 3 x S1/SMB electrode connection cables
and USB serial cables.
· 3 x DW1/AD electrode chamber
Including 3 x S1 electrode disc.
· 1 x OXY/PDU power distribution unit.
For further information, please contact Hansatech Instruments.

mailto:info@hansatech-instruments.com
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Oxytherm+ and Oxylab+ control units draw more power due to the Peltier electrode chamber and
light source control respectively. Therefore, it is not possible to run more than 1 control unit per
power supply.

Linking Control Units Together

Multiple control units are simply linked to the PC via standard USB serial cables. A USB hub may
be required depending on the number of channels you wish to run and the amount of available
ports supplied with your PC. Upon opening OxyTrace+, the software will automatically detect all
units connected to the PC via USB cables. You will see the dialog demonstrated below with
information for each of the connected units.

If you wish to add more units whilst the software is running simply set up the unit with both power

supply and USB connection to the PC and select the  icon on the toolbar to initiate a scan for
the added USB control units. The dialogue above will then open again including information
regarding the newly added unit.
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1.6.7.3 Using a Multi Channel System

Multi-channel Calibration & Configuration

All control units in a multi-channel system must be treated as individual control units and may not
be simultaneously calibrated or configured. Any functions which are channel specific have the
ability to select the required channel number for which actions are to be performed. For example,
the diagram below shows the liquid phase calibration dialogue. Note the channel selection
buttons allowing for individual control units to be selected and calibrated separately.

Multi-channel Stirring

The magnetic stirrer control dialogue allows magnetic stirrers in individual control units to be
operated and configured separately or universally under a single control.

Multi Channel

If using a multi-channel system the following dialogue is generated:
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The 'Enable' check boxes allow the required stirrers to be selected individually. Alternatively
'Enable All' or 'Disable all' can be used to quickly select which stirrers are used.

The 'Matched' functions allows all stirrers to be quickly set to the same value. Pressing this will
grey out the 'Speed' section for all other channels except for the first channel, this box is then
used as the master speed. Any speed entered into this box will be updated for all available
channels.

Once the stirrer speeds have been configured, the 'On' or 'Off' buttons will toggle the stirrers on
and off. Stirrers can then also quickly be turned off/on bu pressing the  icon from the toolbar.

Multi-channel Data Display

Each control unit is capable of recording and plotting 2 separate traces on the OxyTrace+  graph
screen. In addition to the oxygen signal recorded from the electrode disc, an auxiliary signal of 0 -
4V may also be plotted (please click here for full details on recording auxiliary signals). This
means that in a multi-channel system, there is the potential of plotting up to 16 traces per screen
(2 signals from each of the maximum of 8 control units). For this reason, all traces may be
customised in order to differentiate between signals according to colour and data point style from
the window shown below.
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1.7 Oxygraph + System Troubleshooting

1.7.1 Communication Problems between Control Unit and the PC

If no control unit is found when opening OxyTrace+ the following dialogue will be displayed. 
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If the above dialogue is displayed then please follow the steps below:

· Ensure that the control unit is connected to a power supply and the  symbol on the front
panel of the unit is flashing intermittently

· Check the USB connection from the control unit to the PC making sure that if a USB hub is being
used that the latest drivers have been installed

· If using a USB hub try connecting the control unit directly to a USB port on the PC and restart the
software

If you are still experiencing problems with communications, please contact Hansatech Instruments
for further assistance.

1.7.2 Box Test

1.7.2.1 Control Unit Diagnostic Tools

In the event of problems with the electrode system such as drifting or unstable signal, system over
or under scale or lack of response to changes in oxygen tension, it is necessary to isolate the area
of the system that is causing the fault. The electrode system essentially consists of 3 main areas
where faults could occur:

· Control unit
· Electrode disc

mailto:info@hansatech-instruments.com
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· Connection cable

By checking these areas individually on a step by step basis, faults may be relatively easily
diagnosed.

OxyTrace+  features an Instrument Test function which allows the control unit to be subjected to a
series of diagnostic tests with controlled parameters in order to ensure that the electronics of the
control unit are functioning to within specification. This feature can be accessed by selecting
Hardware > Instrument Test from the menu bar.

2 types of test are launched from this window:

· Stirrer Test
· Signal Test 

If any of the Test Status boxes read Failed, please contact Hansatech Instruments fur further
assistance.

mailto:info@hansatech-instruments.com
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1.7.2.2 Stirrer Test

The stirrer test diagnostic allows the function of the magnetic stirrer to be tested. The stirrer test
diagnostic has 2 modes of function:

· Automatic Test mode
· Manual Test mode

When selecting Automatic Test, OxyTrace+  will set the stirrer at 3 different speeds; Off, Slow &
Fast. At each speed, OxyTrace+  requires user input to confirm that the stirrer is either off or
rotating at the appropriate speed.

In Manual Test mode, clicking either of the 3 buttons at the bottom of the Test Stirrer dialogue
allows the functionality of the stirrer to be verified.

1.7.2.3 Signal Test

The Signal Test diagnostics allow the signal processing electronics within the electrode control
unit to be tested. In situations where signal drift, excessive noise or unexpected signal levels are
recorded, the Signal Test diagnostic will be able to indicate if there is a genuine problem with the
control unit itself.

THE SIGNAL TEST REQUIRES BOTH THE ELECTRODE DISC AND THE ELECTRODE CONNECTION
CABLE TO BE DISCONNECTED FROM THE REAR OF THE CONTROL UNIT BEFORE THE TEST IS

INITIATED.
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The signal test diagnostic uses a test resistor to replicate an ideal electrode disc response at air
line which is approximately 2049mV. During the signal test, OxyTrace+  will set the control unit to
different levels of gain and back off and ensure that the signal level responds accordingly.

Manual Test

The diagram below shows the manual test dialogue which is shown when manual test is selected
from the box test options.  The dialog displays the signal from the box in Current (nA) and the
legacy units (mV). The Analogue output is the signal level being output via the phono connector on
the rear of the control unit.

Firstly, ensure that the “Test Resistor” box is checked (see above). The Instrument test diagnostic
uses a test resistor to replicate an ideal electrode disc response at airline.
After leaving the box for a couple of minutes to stabilise the following can be observed:

Current: This should also be a stable signal at around 1700nA.
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Analogue Output: The signal level being output via the phono connector on the rear of the
control unit.
Legacy Units: This signal level should be stable and between 2000-2100mV.

If this information is present and correct now un-check the "Test Resistor" box and leave the unit
for a couple of minutes to stabalise you will then be presented similar signal levels to those
below: 

All signal levels should now be stable with figures close to 0.

If the above is true and your signal levels are both stable and within the ranges stated then

you can be assured that your equipment is fully operational and drift free.

If this is not the case then please contact Hansatech Instruments Ltd for assistance. 

Auto Test
When Auto Test is selected, OxyTrace+  will conduct a signal test using a set of predefined gain
and back off conditions and automatically record the results based on those settings. If the results

mailto:info@hansatech-instruments.com


118 Oxygraph +

© 2019 Hansatech Instruments Ltd

fall within the manufacturers guidelines, the signal test will pass. If the test fails, contact
Hansatech Instruments for further advice in this situation.

1.7.3 Electrode Disc Diagnostic Tools

Possible Causes of Signal Drift.

· Inadequate electrode preparation. If the membrane and space paper have not been applied
properly, i.e. the membrane layer of the electrode dome is particularly uneven, this could result
in an unstable signal as the barrier of electrolyte trapped between the membrane and the
cathode is inconsistent. In areas where the electrolyte layer is thicker, oxygen would take longer
to diffuse through to the platinum cathode than in areas where the electrolyte layer is normal.
Please refer to the Electrode Preparation section for details on correct preparation of the
electrode.

· Improper electrode mounting. When the electrode is mounted into the base of the electrode
chamber, if the base ring is screwed on too tightly, the membrane will become stretched over
the top of the dome. This will result in a higher oxygen diffusion potential through the
membrane to he cathode due to the pores in the PTFE becoming stretched/enlarged. As the
membrane begins to relax, the speed at which oxygen can diffuse through the membrane to the
platinum cathode decreases resulting in a downwards signal drift.

· Temperature control. If the chamber is not correctly temperature controlled or the sample of air
saturated water has not been pre-equilibrated to the correct assay temperature, a signal drift
will occur.

· Disc condition. If the disc has not been cleaned, there may be deposits on the silver anode
which are by-products of the electrochemical reactions taking place on the electrode disc when
polarised. In the first instance, a brown deposit of silver chloride may be present. This deposit
may, in some cases, be desirable as it is an electrical conductor and may improve the sensitivity
of the electrode disc. However, in time, black deposits of silver oxide may build up. This deposit
is an electrical insulator and will therefore decrease the surface area of silver available for
electrochemistry to occur. The response time of the disc will be greatly affected in worst cases.
Please refer to the Electrode Maintenance section for full details on the cleaning procedures for
electrode discs.

· Damaged electrode disc. If the disc has not been maintained correctly or there is a genuine fault
with the disc, a drifting signal may indicate a problem more permanent than those described
above.

If the signal still drifts, please contact Hansatech Instruments for further assistance.

Electrode Signal Increases During Zero Oxygen Stage of Liquid-
Phase Calibration.

mailto:info@hansatech-instruments.com
mailto:info@hansatech-instruments.com
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There have been some issues where, during the zero oxygen stage of liquid-phase calibration, the
electrode signal decreases correctly following the addition of sodium dithionite. However, instead
of reaching a lower plateau, the signal begins to increase above the original airline level. In these
cases, it is more than likely that the sodium dithionite is past it's effective shelf-life and therefore
ineffective.

Either use a fresh batch of sodium dithionite or repeat the calibration using nitrogen gas to
achieve the zero oxygen signal. If the problem still exists, please contact Hansatech Instruments
fur further assistance.

Possible Causes of Excessive Signal Noise.

Noisy signals can be caused by the same issues described in the section above. It is necessary to
check the electrode disc according to the guidelines listed above. If the signal is still noisy, please
contact Hansatech Instruments for further assistance.

1.7.4 Testing the Electrode Connection Cable for Breaks or Electrical Shorts

If the connection cable has an intermittent short circuit, this will be seen on the trace as a sudden
rise to a maximum signal followed by a plateau. Checking the mV signal from the electrode disc in

mailto:info@hansatech-instruments.com
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the Instrument Summary window ( Hardware > Instrument Summary ) should show that the signal
is over scaled at 4095 mV when plateaued. If the signal remains at his level, and a problem with
the electrode disc and control unit have been ruled out, it may be a dead short in the connection
cable. If the signal only remains at this level temporarily and manipulating the cable restores the
signal, the problem may be an intermittent short caused by a cable break.

The connection cable may also be "buzzed out" using a multimeter.


	Table of Contents
	Oxygraph +
	Introduction to the Oxygraph +
	Oxygraph + Inventory
	S1 Electrode Disc
	Introduction
	Introduction
	Electrode Disc Theory
	Operational Principles

	Electrode Preparation
	Electrode Disc Preparation
	Testing the Response of the Electrode Disc 

	Electrode Disc Cleaning
	Electrode Disc Maintenance
	Cleaning the Electrode Disc
	Electrode Disc Rinsing, Drying & Storage
	Leaving the Electrode Disc Polarised Overnight


	DW1 Oxygen Electrode Chamber
	Introduction
	Introduction to the DW1 
	Features of DW1
	DW1 Transmission Properties 
	DW1 Plunger Assembly

	Setting up the DW1
	Installing the S1 Electrode Disc in an Electrode Chamber
	Temperature Control
	Introduction to Temperature Control
	Temperature Effects on Liquid-Phase Samples
	Temperature Effects on the Electrode Disc

	Sample Stirring

	Care and Maintenence
	Electrode Chamber Disassembly
	DW1 Spare Parts

	Modifications

	Oxygraph + Electrode Control Unit
	Setting up the Oxygraph +
	Oxygraph Plus Electrode Control Unit


	OxyTrace + Software
	Startup
	OxyTrace + Software Initialisation
	Testing the Electrode Disc Response

	OxyTrace + Workspace
	Menu Bar
	File Menu
	Hardware Menu
	Calibrate Menu
	View Menu
	Graph Menu
	Data Bar Menu
	Tools Menu
	Rate menu
	Help Menu

	OxyTrace + Toolbar
	Graph Area
	Introduction to the Graph Area
	Axes Settings
	Trace Settings

	Data Bar

	System Setup and Calibration
	Instrument Summary
	Data Aquisition Rate
	Sample Stirring
	Sample Stirring
	Operating the Magnetic Stirrer

	Programme Options
	Quantum Yield Measurements

	System Calibration
	Liquid Phase Calibration
	Principles of Liquid-Phase Calibration
	Liquid Phase Calibration Process
	Manual Calibration Process
	Viewing Calibration Details
	Set Calibration Warning

	Gas Phase Calibration
	Principles of Gas-Phase Calibration
	Gas Phase Calibration Process
	Viewing Calibration Details
	Set Calibration Warning


	Data Handling
	Event Marking
	Adding Event Marks
	Editing Event Marks
	Deleting Event Marks

	File Information
	Rate Measurements
	Live Rate
	Setup Live Rate Display
	Plotting Live Rate Data

	Manual Rate Measurements

	Tabulated Data
	Exporting Data to Other Software Packages
	Printing Data
	Viewing Previously Saved Data

	Recording an Auxiliary Signal
	Connecting the Auxiliary Device 
	Enabling the Auxiliary Device
	Calibrating the Auxilary Device 
	Auxiliary Channel Calibration
	Auxiliary Device Calibration
	pH Device Calibration
	Ion Selective Electrode (ISE) Calibration
	Auxiliary Device Calibration Details
	Set Calibration Warning


	Multi Channel Systems
	Introduction to Multi-channel Systems
	Setting Up a Multi Channel System
	What Additional Hardware is Required?
	Linking Control Units Together

	Using a Multi Channel System
	Multi-channel Calibration & Configuration
	Multi-channel Stirring
	Multi-channel Data Display



	Oxygraph + System Troubleshooting
	Communication Problems between Control Unit and the PC
	Box Test
	Control Unit Diagnostic Tools
	Stirrer Test
	Signal Test

	Electrode Disc Diagnostic Tools
	Testing the Electrode Connection Cable for Breaks or Electrical Shorts



